!828 Manual/Mac Page 1 Thursday, March 1, 2001 9:46 AM

MOTU 828

™

User’s Guide for Macintosh

1280 Massachusetts Avenue
Cambridge, MA 02138
Business voice: (617) 576-2760
Business fax: (617) 576-3609
Tech support phone: (617) 576-3066
Tech support fax: (617) 354-3068
Tech support email: techsupport@motu.com
Web site: www.motu.com

!828 Manual/Mac Page 2 Thursday, March 1, 2001 9:46 AM

SAFETY PRECAUTIONS AND ELECTRICAL REQUIREMENTS
WARNING: TO REDUCE THE RISK OF FIRE OR ELECTRICAL SHOCK, DO NOT EXPOSE THIS APPLIANCE TO RAIN OR OTHER MOISTURE.
CAUTION: TO REDUCE THE RISK OF ELECTRICAL SHOCK, DO NOT REMOVE COVER. NO USER-SERVICEABLE PARTS INSIDE. REFER SERVICING TO
QUALIFIED SERVICE PERSONNEL.
WARNING: DO NOT PERMIT FINGERS TO TOUCH THE TERMINALS OF PLUGS WHEN INSTALLING OR REMOVING THE PLUG TO OR FROM THE OUTLET.
WARNING: IF NOT PROPERLY GROUNDED THE MOTU 828 COULD CAUSE AN ELECTRICAL SHOCK.
The MOTU 828 is equipped with a three-conductor cord and grounding type plug which has a grounding prong, approved by Underwriters' Laboratories and the Canadian Standards Association.This
plug requires a mating three-conductor grounded type outlet as shown in Figure A below.
If the outlet you are planning to use for the MOTU 828 is of the two prong type, DO NOT REMOVE OR ALTER THE GROUNDING PRONG IN ANY MANNER. Use an adapter as shown below and
always connect the grounding lug to a known ground. It is recommended that you have a qualified electrician replace the TWO prong outlet with a properly grounded THREE prong outlet. An adapter
as illustrated below in Figure B is available for connecting plugs to two-prong receptacles.
Figure A

Figure B
Grounding lug
Screw
3-prong plug

Make sure this is connected
to a known ground.

3-prong plug

Grounding prong
Two-prong receptacle

Properly grounded 3-prong outlet
Adapter

WARNING: THE GREEN GROUNDING LUG EXTENDING FROM THE ADAPTER MUST BE CONNECTED TO A PERMANENT GROUND SUCH AS TO A
PROPERLY GROUNDED OUTLET BOX. NOT ALL OUTLET BOXES ARE PROPERLY GROUNDED.
If you are not sure that your outlet box is properly grounded, have it checked by a qualified electrician. NOTE: The adapter illustrated is for use only if you already have a properly grounded two-prong
receptacle. Adapter is not allowed in Canada by the Canadian Electrical Code. Use only three wire extension cords which have three-prong grounding type plugs and three-prong receptacles which
will accept the MOTU 828 plug.

IMPORTANT SAFEGUARDS
1.
2.
3.
4.
5.
6.
7.
8.

Read instructions - All the safety and operating instructions should be read before operating the MOTU 828.
Retain instructions - The safety instructions and owner's manual should be retained for future reference.
Heed Warnings - All warnings on the MOTU 828 and in the owner's manual should be adhered to.
Follow Instructions - All operating and use instructions should be followed.
Cleaning - Unplug the MOTU 828 from the computer before cleaning and use a damp cloth. Do not use liquid or aerosol cleaners.
Overloading - Do not overload wall outlets and extension cords as this can result in a risk of fire or electrical shock.
Power Sources - This MOTU 828 should be operated only from the type of power source indicated on the marking label. If you are not sure of the type of power supply to your location, consult your local power company.
Power-Cord Protection - Power-supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or against them. Pay particular attention to cords and plugs, convenience receptacles, and
the point where they exit from the MOTU 828.
9. Lightning - For added protection for the MOTU 828 during a lightning storm, unplug it from the wall outlet.This will prevent damage to the MOTU 828 due to lightning and power line surges.
10. Servicing - Do not attempt to service this MOTU 828 yourself as opening or removing covers will expose you to dangerous voltage and other hazards. Refer all servicing to qualified service personnel.
11. Damage Requiring Service - Unplug the MOTU 828 from the computer and refer servicing to qualified service personnel under the following conditions.
a. When the power supply cord or plug is damaged.
b. If liquid has been spilled or objects have fallen into the MOTU 828.
c. If the MOTU 828 has been exposed to rain or water.
d. If the MOTU 828 does not operate normally by following the operating instructions in the owner's manual.
e. If the MOTU 828 has been dropped or the cabinet has been damaged.
f. When the MOTU 828 exhibits a distinct change in performance, this indicates a need for service.
12. Replacement Parts - When replacement parts are required, be sure the service technician has used replacement parts specified by the manufacturer or have the same characteristics as the original part. Unauthorized substitutions
may result in fire, electric shock or other hazards.
13. Safety Check - Upon completion of any service or repairs to this MOTU 828, ask the service technician to perform safety checks to determine that the product is in safe operating conditions.

ENVIRONMENT
Operating Temperature: 10°C to 40°C (50°F to 104°)

AVOID THE HAZARDS OF ELECTRICAL SHOCK AND FIRE
Do not handle the power cord with wet hands. Do not pull on the power cord when disconnecting it from an AC wall outlet. Grasp it by the plug.

INPUT
Line Voltage: 100 - 120 volts AC, RMS (US and Japan) or 220 - 250 volts AC, RMS (Europe). Frequency: 47 - 63 Hz single phase. Power: 7 watts maximum.

CAUTION: DANGER OF EXPLOSION IF BATTERY IS REPLACED. REPLACE ONLY WITH THE SAME OR EQUIVALENT TYPE RECOMMENDED BYMANUFACTURER. DISPOSE OF USED BATTERY ACCORDING TO MANUFACTURER’S INSTRUCTIONS.
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About the Mark of the Unicorn License Agreement and
Limited Warranty on Software
TO PERSONS WHO PURCHASE OR USE THIS PRODUCT: carefully read all
the terms and conditions of the “click-wrap” license agreement presented to you
when you install the software. Using the software or this documentation indicates
your acceptance of the terms and conditions of that license agreement.
Mark of the Unicorn, Inc. (“MOTU”) owns both this program and its documentation.
Both the program and the documentation are protected under applicable copyright,
trademark, and trade-secret laws. Your right to use the program and the
documentation are limited to the terms and conditions described in the license
agreement.

Reminder of the terms of your license
This summary is not your license agreement, just a reminder of its terms. The
actual license can be read and printed by running the installation program for the
software. That license agreement is a contract, and clicking “Accept” binds you and
MOTU to all its terms and conditions. In the event anything contained in this
summary is incomplete or in conflict with the actual click-wrap license agreement,
the terms of the click-wrap agreement prevail.
YOU MAY: (a) use the enclosed program on a single computer; (b) physically
transfer the program from one computer to another provided that the program is
used on only one computer at a time and that you remove any copies of the
program from the computer from which the program is being transferred; (c) make
copies of the program solely for backup purposes.You must reproduce and include
the copyright notice on a label on any backup copy.
YOU MAY NOT: (a) distribute copies of the program or the documentation to
others; (b) rent, lease or grant sublicenses or other rights to the program; (c)
provide use of the program in a computer service business, network, time-sharing,
multiple CPU or multiple user arrangement without the prior written consent of
MOTU; (d) translate, adapt, reverse engineer, decompile, disassemble, or
otherwise alter the program or related documentation without the prior written
consent of MOTU.
MOTU warrants to the original licensee that the disk(s) on which the program is
recorded be free from defects in materials and workmanship under normal use for
a period of ninety (90) days from the date of purchase as evidenced by a copy of
your receipt. If failure of the disk has resulted from accident, abuse or misapplication of the product, then MOTU shall have no responsibility to replace the disk(s)
under this Limited Warranty.
THIS LIMITED WARRANTY AND RIGHT OF REPLACEMENT IS IN LIEU OF,
AND YOU HEREBY WAIVE, ANY AND ALL OTHER WARRANTIES, BOTH
EXPRESS AND IMPLIED, INCLUDING BUT NOT LIMITED TO WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE
LIABILITY OF MOTU PURSUANT TO THIS LIMITED WARRANTY SHALL BE
LIMITED TO THE REPLACEMENT OF THE DEFECTIVE DISK(S), AND IN NO
EVENT SHALL MOTU OR ITS SUPPLIERS, LICENSORS, OR AFFILIATES BE
LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING
BUT NOT LIMITED TO LOSS OF USE, LOSS OF PROFITS, LOSS OF DATA OR
DATA BEING RENDERED INACCURATE, OR LOSSES SUSTAINED BY THIRD
PARTIES EVEN IF MOTU HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS
WHICH MAY VARY FROM STATE TO STATE. SOME STATES DO NOT ALLOW
THE LIMITATION OR EXCLUSION OF LIABILITY FOR CONSEQUENTIAL
DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Limited Warranty on Hardware
Mark of the Unicorn, Inc. and S&S Research (“MOTU/S&S”) warrant this
equipment against defects in materials and workmanship for a period of NINETY
(90) DAYS from the date of original retail purchase. This warranty applies only to
hardware products; MOTU software is licensed and warranted pursuant to
separate written statements.
If you discover a defect, first write or call Mark of the Unicorn at (617) 576-2760 to
obtain a Return Merchandise Authorization Number. No service will be performed
on any product returned without prior authorization. MOTU will, at its option, repair
or replace the product at no charge to you, provided you return it during the
warranty period, with transportation charges prepaid, to Mark of the Unicorn, Inc.,
1280 Massachusetts Avenue, MA 02138. You must use the product’s original
packing material for in shipment, and insure the shipment for the value of the
product. Please include your name, address, telephone number, a description of
the problem, and the original, dated bill of sale with the returned unit and print the
Return Merchandise Authorization Number on the outside of the box below the
shipping address.
This warranty does not apply if the equipment has been damaged by accident,
abuse, misuse, or misapplication; has been modified without the written
permission of MOTU, or if the product serial number has been removed or defaced.
ALL IMPLIED WARRANTIES, INCLUDING IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE
LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF THE
ORIGINAL RETAIL PURCHASE OF THIS PRODUCT.
THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND
IN LIEU OF ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED. No
MOTU/S&S dealer, agent, or employee is authorized to make any modification,
extension, or addition to this warranty.
MOTU/S&S ARE NOT RESPONSIBLE FOR SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES RESULTING FROM ANY BREACH OF
WARRANTY, OR UNDER ANY LEGAL THEORY, INCLUDING LOST PROFITS,
DOWNTIME, GOODWILL, DAMAGE OR REPLACEMENT OF EQUIPMENT
AND PROPERTY AND COST OF RECOVERING REPROGRAMMING, OR
REPRODUCING ANY PROGRAM OR DATA STORED IN OR USED WITH
MOTU/S&S PRODUCTS.
Some states do not allow the exclusion or limitation of implied warranties or liability
for incidental or consequential damages, so the above limitation or exclusion may
not apply to you. This warranty gives you specific legal rights, and you may have
other rights which vary from state to state.
MOTU, AudioDesk, MOTU, Mark of the Unicorn and the unicorn silhouette logo are
trademarks of Mark of the Unicorn, Inc.

This equipment has been type tested and found to comply with the limits for a class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the instruction manual,
may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause interference to radio
or television equipment reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by any combination of the following measures:
• Relocate or reorient the receiving antenna

Update Policy

• Increase the separation between the equipment and the receiver

In order to be eligible to obtain updates of the program, you must complete and
return the attached Mark of the Unicorn Purchaser Registration Card to MOTU.

• Plug the equipment into an outlet on a circuit different from that to which the receiver is connected

Copyright Notice
Copyright © 2001 by Mark of the Unicorn, Inc. All rights reserved. No part of this
publication may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any human or computer language, in any form or by any
means whatsoever, without express written permission of Mark of the Unicorn,
Inc., 1280 Massachusetts Avenue, Cambridge, MA, 02138, U.S.A.

If necessary, you can consult a dealer or experienced radio/television technician for additional
assistance.
PLEASE NOTE: only equipment certified to comply with Class B (computer input/output devices,
terminals, printers, etc.) should be attached to this equipment, and it must have shielded interface
cables in order to comply with the Class B FCC limits on RF emissions.
WARNING: changes or modifications to this unit not expressly approved by the party
responsible for compliance could void the user's authority to operate the equipment.

These three input trim knobs provide up to 40dB of gain for
inputs 3 through 8 (in pairs). These inputs don’t have mic
pre-amps, so they are best for line-level inputs such as
synthesizers, drum machines, samplers, effects processors
and other studio gear. If your input is hot (+4dB), start
with the trim knob at about 10 or 11 o’clock. If you’re
dealing with a synth or consumer audio product, try 2
o’clock. Then calibrate the input using the level meters in
your host audio software to make sure the level isn’t
clipping (clipping is bad and causes unwanted distortion).

inputs 1-2

Dynamic microphone
(no phantom power)
Example: Shure SM57

Condenser microphone
(with 48V phantom power)
Example: Octavia MC01

If you plug in a condenser microphone (with phantom power),
start with the trim knob at about 12 o’clock. For a dynamic mic (no
phantom), try 3 o’clock. Then calibrate the input using the level
meters in your host audio software to make sure the level isn’t
clipping (clipping is bad and causes unwanted distortion).

These two trim knobs provide up to 40dB of gain for inputs 1 and
2. Because inputs 1 and 2 also have microphone pre-amps, you
can plug just about anything into them: a microphone, a guitar, an
synth — you name it.

This switch provides
phantom power for
microphones on inputs
1 and 2. Up is on.

The MOTU 828 lets you monitor any
analog input (or input pair) via the main
outs (and the headphone out). This knob
controls the level of this monitored signal.

These lights indicate signal
presence on the analog
inputs and outputs. Their
threshold is around -42 dB.
They do not indicate clipping
in any way; use your host
audio software level meters
to calibrate input and output
levels.

inputs 3-8

FireWire is a “plug-and-play”
protocol. That means that you
can turn off the MOTU 828
and turn it back on without
restarting your computer.
Keep in mind, however, that if
you wish to change the MOTU
828’s settings in the MOTU
828 Control Panel, the MOTU
828 needs to be plugged in
and switched on.

Line guitar (clean)

Synths, CD players,
consumer electronics, etc.

Pro-level gear
Line guitar (with heavy distortion)

These lights indicate the global sample rate at which the
MOTU 828 is operating. Use the MOTU 828 Control Panel
to set the sample rate or to choose an external clock
source, from which the sample rate will be derived.
When no sample clock is currently present, these two
lights flash rapidly. For example, if you’ve set the MOTU
828 to slave to an external clock, such as ADAT, but there
is no clock signal currently being detected, these lights
will flash.

These lights indicate
signal presence on the
digital inputs and
outputs.Their threshold is
around -42 dB. They do
not indicate clipping in
any way; use your host
audio software level
meters to calibrate inputs
and outputs.

Approximate trim positions on
inputs 3 through 8 for guitars and
other studio gear. Start with these
positions and then adjust according to the level meters in your
audio software.

Quick Reference: MOTU 828 Front Panel

Approximate trim positions on
inputs 1 and 2 for a microphone.
Start with these positions and
then adjust according to the level
meters in your audio software.

This is a standard quarterinch stereo headphone jack.
Its output matches the main
outs on the rear panel. The
volume knob controls both
the headphone out and the
main outs.

0
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One special note: you can choose independent
formats for the optical IN and OUT. For
example, you could choose ADAT for the
optical IN (for, say, eight channels of input
from your digital mixer) and S/PDIF for the
optical OUT (for, say, your DAT machine).

These optical digital I/O connectors can be
connected either to an ADAT-compatible
“lightpipe” device (such as a digital mixer) or
to a S/PDIF optical (“TOSLink”) compatible
device, such as an effects processor or DAT
machine. Be sure to set the format in the
MOTU 828 Control Panel software. (see
“Optical input/output” on page 37 for details.)
ADAT optical supplies eight channels of 24-bit
digital I/O, and TOSLink is stereo.

Connect the MOTU 828 to
the computer here using
the standard 1394
FireWire cable provided
with your MOTU 828.

These jacks provide stereo, 24-bit
S/PDIF digital input and output.

The signal that comes out of these
outputs is a mix of analog outputs 1 and 2
and any live CueMix™ Plus input that you
have chosen to monitor from a MOTU 828
input (or input pair).To hear disk tracks in
your audio software on these main outs,
assign the disk tracks (and master fader)
to Analog Outs 1-2.

These two balanced, quarter-inch jacks
serve as the MOTU 828’s main outputs.
You can connect them to a set of powered
studio monitors and then control the
volume from the front panel “Main”
volume knob.

These Neutrik™ jacks for inputs 1 and 2 accept
either a mic (XLR) cable or a quarter-inch plug.
Each is equipped with a mic preamp. 48V
phantom power can be supplied via the frontpanel switch. Since these inputs have mic
preamps, they are ideal for microphones,
guitars and other low-level sources.

Analog outputs 1 and 2 are
duplicated on the MOTU
828’s main outputs (to the
right), as well as the front
panel stereo headphone
jack. However, these outputs
do not include any live
CueMix™ Plus audio.

The MOTU 828’s eight analog outputs are goldplated, balanced +4dB TRS (tip/ring/sleeve)
quarter-inch connectors that can also accept
an unbalanced plug. They are equipped with
24-bit, 128x oversampling converters.

These six analog inputs are gold-plated,
balanced TRS (tip/ring/sleeve) quarterinch connectors that can also accept an
unbalanced plug. The front panel trim
allows you to adjust them for either
+4dB or -10dB input signals. They have
24-bit, 64x oversampling converters.
These inputs (3 through 8) do not have
microphone preamps, so they are best
used for synthesizers, drum machines,
effects processors, and other instruments. However, because the trim knobs
on the front panel give you 40 dB of
input gain adjustment, you can probably
get away with plugging in a guitar
(depending on the guitar).

Connect a standard foot switch
here for hands-free punch-in and
punch-out during recording. For
details about how to set this up,
see “Enable Pedal” on page 37.

Quick Reference: MOTU 828 Rear Panel

If you are using the MOTU 828 with an ADAT, use this
standard ADAT SYNC INPUT to connect the MOTU 828
to the end of your ADAT sync chain. For example, if
you have three ADATs, chain the ADATs in the usual
fashion (SYNC OUT to SYNC IN, etc.), and then
connect the last ADAT’s SYNC OUT to this SYNC IN.This
connection allows you to make sample-accurate
audio transfers between AudioDesk (or other
sample-accurate software) and the ADATs. If you have
a MOTU MIDI Timepiece AV or Digital Timepiece, make
it the master of the ADAT SYNC chain so that you can
control everything from AudioDesk (or your other
MIDI Machine Control compatible software).

0
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Quick Reference: MOTU 828 Control Panel
CHAPTER
If any of these settings are grayed out (not available), see
“If MOTU 828 settings are grayed out” on page 39.
Determines the master clock source for your entire
MOTU 828 system. If you’re just using the analog
ins and outs, set this to ‘Internal’.The other settings
are for digital transfers via S/PDIF or external
synchronization via the ADAT SYNC in port.
Choosing a smaller setting here reduces the delay
you may hear when listening to live input that you
are running through effects plug-ins in your
software. But lower settings also increase the strain
on your computer. For details, see “Samples Per
Buffer” on page 36.

If you want to hear your Macintosh system beeps, as
well as the audio output of any Sound Managercompatible s software, through the MOTU 828
(instead of the built-in speaker in your Mac), check
this box and choose the desired MOTU 828 input
and output from these menus.

Choose the global sample rate for the system here.
Choose the desired optical format you’d like to
use for the optical input and output. Note that
they don’t have to be the same.
This is the MOTU 828’s no-latency CueMix™
Plus monitoring feature. The inputs you
choose here will be mixed with the main outs
and can be controlled with the ‘monitor’
volume knob on the front panel.

If you have a foot switch connected to the
MOTU 828, these settings let you map the foot
switch to any Macintosh keyboard key for
both the up and down position.

How to access these settings
The MOTU 828 Control Panel gives you complete
control over the settings in your MOTU 828 hard
disk recording system. There are several ways to
access these settings. But the settings are the
same, regardless of how you access them.
■

From the Mac OS Apple menu, choose
Control Panels>MOTU 828 Control Panel.

■

From within AudioDesk™ or Digital
Performer™, go to the Basics menu and
choose MOTU Audio System options>
Configure Hardware Driver.

■

Click on the 828 icon in the Macintosh
Control Strip.

Digital Performer

AudioDesk

The MOTU 828 Control Panel above is the same as the “Configure Hardware
Driver” dialogs found in AudioDesk and Digital Performer (in their Basics
menu). For details about the ‘Auto Monitor’ option, see “Auto Monitor” on
page 43 for Digital Performer and “Auto Monitor” on page 49 for AudioDesk.

7
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CHAPTER 1

About the MOTU 828

OVERVIEW
The MOTU 828 is a computer-based hard disk
recording system for Mac OS and Windows that
offers 18 simultaneous inputs and outputs. The
MOTU 828 consists of a standard 19-inch,
single-space, rack-mountable I/O unit that
connects directly to a computer via a standard
IEEE 1394 FireWire™ cable. The MOTU 828 offers
the following:
■

Eight 24-bit analog inputs and outputs

■

Eight-channel ADAT optical digital I/O

■

S/PDIF (optical and RCA)

■

Two extra analog main outs

■

Two mic preamps on inputs 1 and 2

■

48V phantom power for both mic inputs

■

ADAT sync in

■

Foot switch for hands-free punch-in/out

■

Headphone jack

■

Main volume knob (for headphone + main outs)

■

CueMix™ Plus no-latency monitoring

■

Individual front-panel input trim knobs

With a variety of I/O formats, mic preamps,
no-latency monitoring of live input and synchronization capabilities, the MOTU 828 is a complete,
portable “studio in a box” when used with a
Macintosh or Windows computer. The MOTU 828
system includes AudioDesk™, full-featured audio
workstation software for Mac OS that supports
both 16-bit and 24-bit recording. Also included is

an ASIO driver for multi-channel operation with
any Macintosh audio software that supports ASIO
drivers.

THE MOTU 828 I/O REAR PANEL
The MOTU 828 rear panel has the following
connectors:
■ Eight gold-plated, balanced +4dB quarter-inch
(TRS) analog outputs (with 24-bit converters)
■ Six gold-plated, balanced +4 dB quarter-inch
(TRS) analog inputs (with 24-bit converters)
■ Two additional analog mic/line inputs on
Neutrik combo (XLR/quarter-inch) connectors
equipped with mic pre-amps
■ One set of ADAT optical ‘light pipe’ connectors
(8 channels of ADAT optical I/O), individually
switchable to optical S/PDIF (‘TOSLink’)
■

RCA S/PDIF in/out

■ Two balanced +4 quarter-inch TRS main
outputs with volume knob (on the front panel)
■

One 9-pin ADAT SYNC IN connector

■

One 1394 FireWire jack

18 simultaneous inputs and outputs
All MOTU 828 inputs and outputs can be used
simultaneously, for a total of 18 inputs and outputs
(8 analog + 8 ADAT optical + 2 RCA S/PDIF).
Analog
The analog inputs are equipped with 24-bit, 64x
oversampling A/D converters. The analog outputs
have 24-bit 128x oversampling D/A converters. All
audio is carried to the computer in a 24-bit data
stream. The eight analog outputs are on balanced
9
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TRS +4dB quarter-inch jacks, as are the six
quarter-inch input jacks below them. All of these
jacks can also accept unbalanced plugs.

output jacks can operate independently. For
example, the optical input can be set to TOSLink
while the optical output is set to ADAT.

All analog inputs can be gain-adjusted with the
trim knobs on the front panel. The range of these
knobs is approximately 40 dB.

ADAT sync: sample-accurate synchronization
The MOTU 828’s standard 9-pin ADAT SYNC IN
connector provides sample-accurate synchronization with all Alesis ADAT tape decks connected
to the system—or any device that supports the
ADAT sync format. For example, if you digitally
transfer a single track of material from an ADAT
via light pipe into audio workstation software on
the computer, and then transfer the track back to
the ADAT, it will be recorded exactly at its original
location, down to the sample.

Mic inputs
Analog inputs 1 and 2 are each equipped with a mic
preamp on a Neutrik™ combo-style connector that
accepts either a mic (XLR) cable or a cable with a
quarter-inch plug. Defeatable 48V phantom power
is supplied by a front panel switch.
Main Outs
For main stereo output, analog outputs 1 and 2 are
duplicated as a stereo pair of balanced, +4dB
quarter-inch TRS jacks. If an input (or input pair)
is being monitored via the MOTU 828’s CueMix™
Plus monitoring feature, the monitored signal is
summed with the main outs. You can control the
volume of the main outs with the front panel
volume knob. You can independently control the
CueMix Plus monitored signal with the Monitor
level knob on the front panel.
Optical
The MOTU 828 optical jacks support two digital
audio formats: ADAT and S/PDIF. The ADAT
optical format provides eight channels of 24-bit
digital audio at either 44.1 or 48 kHz. The optical
S/PDIF format (often referred to as TOSLink),
supplies stereo S/PDIF input or output.
S/PDIF
The MOTU 828 rear panel provides S/PDIF input
and output in two different formats: RCA “coax”
and optical “TOSLink”. The RCA jacks are
dedicated to the S/PDIF format. The TOSLink
jacks can be used either for the TOSLink format or
for ADAT optical. In addition, the optical input and

Punch in/out
The quarter-inch Punch in/out jack accepts a
standard foot switch. When you push the foot
switch, the MOTU 828 triggers a programmable
keystroke on the computer keyboard. For example,
with MOTU’s Digital Performer audio sequencer
software, the foot switch triggers the 3 key on the
numeric keypad, which toggles recording in
Digital Performer. Therefore, pressing the foot
switch is the same as pressing the 3 key. The MOTU
828 Control Panel software lets you program any
keystroke you wish.
1394 FireWire
The 1394 FireWire jack accepts a standard IEEE
1394 FireWire cable to connect the MOTU 828 to a
FireWire-equipped Macintosh or Windows
computer.

THE MOTU 828 FRONT PANEL
Headphone output and main volume control
The MOTU 828 front panel includes a quarter-inch
stereo headphone output jack and volume knob.
The headphone output matches the main stereo
outs, and the volume knob controls both the
headphones and the main outs.

10
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CueMix™ Plus no-latency monitoring
The MOTU 828 provides CueMix™ Plus
no-latency monitoring from any analog input (or
input pair). The CueMix monitored signal is mixed
with outputs 1-2 (which are duplicated on the main
outs). An independent volume knob is provided
for the monitored signal.
Input trim knobs and phantom power switch
The Input Gain section provides 40 dB of trim for
the eight analog inputs. Inputs 1 and 2 have
independent trim knobs, while inputs 3 through 8
have one knob per input pair (3-4, 5-6, and 7-8).
The phantom power switch provides 48V phantom
power to the two mic inputs. Up is on; down is off.
Activity lights
The front panel of the MOTU 828 displays several
banks of activity LEDs. The Analog Activity,
S/PDIF and Optical lights display the presence of
signal on the input or output. The threshold for
these lights is approximately -42 dB. The Clock
lights indicate the global sample rate (as chosen in
the MOTU 828 Control Panel software).

editing, automated virtual mixing, graphic editing
of ramp automation, real-time effects plug-ins with
32-bit floating point processing, crossfades,
support for many third-party audio plug-ins (in
the MOTU Audio System and Adobe Premiere
formats), background processing of file-based
operations, sample-accurate editing and
placement of audio, and more.

DIGITAL PERFORMER
The MOTU 828 system is fully integrated with
MOTU’s award-winning Digital Performer audio
sequencer software package.

OTHER HOST AUDIO SOFTWARE
The MOTU 828 system includes a standard
Mac OS Sound Manager driver for stereo I/O with
any audio application that supports Sound
Manager.
The MOTU 828 also includes a Macintosh ASIO
driver for multi-channel compatibility with any
audio application that supports ASIO drivers.

A COMPUTER-BASED SYSTEM
16-BIT AND 24-BIT RECORDING
The MOTU 828 system handles all data with a
24-bit signal path, regardless of the I/O format. You
can record and play back 16-bit or 24-bit audio files
at either 44.1 or 48 KHz via any of the MOTU 828’s
analog or digital inputs and outputs. 24-bit audio
files can be recorded with any compatible host
application that supports 24-bit recording.

AUDIODESK
AudioDesk is a full-featured, 24-bit audio
workstation software package included with the
MOTU 828 system (for Macintosh only).
AudioDesk provides multi-channel waveform

Regardless of what software you use with the
MOTU 828, the host computer determines the
number of tracks the software can record and play
simultaneously, as well as the amount of real-time
effects processing you can apply to your mix. A
faster computer with more RAM and faster hard
drives will allow more simultaneous tracks and
real-time effects than a slower computer with less
RAM and slower hard drives. Today’s fastest
computers can typically play as many as 32 tracks
or more. Standard third-party SCSI acceleration
products can also help you achieve higher track
counts.
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CHAPTER 2

Packing List and
Macintosh System Requirements

PACKING LIST

MACINTOSH SYSTEM REQUIREMENTS

The MOTU 828 ships with the items listed below. If
any of these items are not present in your MOTU
828 box when you first open it, please immediately
contact your dealer or MOTU.

The MOTU 828 system requires the following
Macintosh system:

■

One MOTU 828 I/O rack unit

■

One 1394 “FireWire” cable

■

Power cord

■

One MOTU 828 Mac/Windows manual

■

One AudioDesk Manual

■

One cross-platform CD-ROM

■

Product registration card

■ A G3/300Mhz Power Macintosh or faster
equipped with at least one FireWire port
■ At least 64 Mb (megabytes) of RAM (128 Mb or
more is recommended)

Mac OS version 8.6 or later (MacOS 9 or later is
recommended)
■

■ FireWire Enabler and FireWire Support system
extensions 2.4 or later
■

A large hard drive (preferably at least 8 Gb)

PLEASE REGISTER TODAY!
Please send in the registration card included with
your MOTU 828 system. As a registered user, you
will be eligible to receive on-line technical support
email and announcements about product
enhancements as soon as they become available.
Only registered users receive these special update
notices, so please, complete and mail this
registration card!
There is also an AudioDesk software registration
card found at the beginning of your AudioDesk
manual. Please be sure to fill out and return this
card as well, so that you will be eligible to receive
on-line technical support email and
announcements about AudioDesk software
enhancements as soon as they become available.
Thank you for taking the time to register your new
MOTU products!

13
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CHAPTER 3

Installing the MOTU 828 Hardware

OVERVIEW

CONNECT THE MOTU 828 INTERFACE

Here’s an overview for installing the MOTU 828:

1 Plug one end of the MOTU 828 FireWire cable
(included) into the FireWire socket on the
computer as shown below in Figure 3-1.

Connect the MOTU 828 interface . . . . . . . . . . . .15
Connect the MOTU 828 audio interface to the
computer with the supplied FireWire cable.

2 Plug the other end of the FireWire cable into the
MOTU 828 I/O as shown below in Figure 3-1.

Connect inputs and outputs . . . . . . . . . . . . . . . . .16
Make optical and analog connections as desired.
A typical studio setup (no mixer) . . . . . . . . . . . .17
An example setup for computer-based mixing/FX.
Using the MOTU 828 with a mixer . . . . . . . . . . .18
An example setup for a mixer-based studio.
Making sync connections . . . . . . . . . . . . . . . . . . .19
If you need to resolve the MOTU 828 with other
devices in your studio, make the necessary
synchronization connections.
Do you need a synchronizer? . . . . . . . . . . . . . . . .20
Sample-accurate sync. . . . . . . . . . . . . . . . . . . . . . .21
Sample-accurate sync with ADATs . . . . . . . . . . .22
ADAT sync with no synchronizer . . . . . . . . . . . .23
Sync to SMPTE, word clock, video . . . . . . . . . . .24
Syncing optical devices . . . . . . . . . . . . . . . . . . . . .25
Syncing S/PDIF devices . . . . . . . . . . . . . . . . . . . . .26
Syncing large systems. . . . . . . . . . . . . . . . . . . . . . .27
Figure 3-1: Connecting the MOTU 828 to the computer.
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CONNECT INPUTS AND OUTPUTS
The MOTU 828 audio interface has the following
input and output connectors:
■

8 balanced, +4 dB quarter-inch analog outputs

■

6 balanced +4 dB quarter-inch analog inputs

■

2 Neutrik™ XLR/quarter-inch analog inputs

■

2 balanced, +4 dB quarter-inch TRS main outs

■

1 pair of RCA S/PDIF in and out

■ 1 pair of optical in/out switchable between
ADAT (“Lightpipe”) or optical S/PDIF (TOSLink)

Here are a few things you should keep in mind as
you are making these connections to other devices.
Mic/line inputs
The mic/line inputs (1 and 2) have mic preamps, so
connect your microphone(s) to inputs 1 and/or 2.
If your microphone requires phantom power, move
the 48V phantom power switch on the front panel
to the up (enabled) position. Use the trim knobs on
the front panel to adjust the input level as needed
for each input.
Quarter-inch analog
The quarter-inch analog inputs (3-8) and outputs
(1-8) are balanced TRS connectors that can also
accept an unbalanced plug. Use the trim knobs on
the front panel to adjust the input level as needed
for each input (or input pair).
Optical
Reminder: optical goes OUT to IN and IN to OUT,
like MIDI.

The optical connectors can be connected to either
an ADAT “lightpipe” device or an optical S/PDIF
“TOSLink” device. Just make the connections as
needed and then you’ll set the format later on in the
MOTU 828 Control Panel. The input is
independent from the output; for example, you
could connect ADAT optical input from your
digital mixer and connect optical output to the
TOSLink input on your DAT deck.
Main outs
The main outputs, as well as the headphone output
on the front panel, match the output from Analog
outputs 1-2. In addition, any live inputs that are
being monitored via CueMix™ Plus are summed to
the signal on the main outs. The main out volume
is controlled by the main volume knob on the front
panel. In a standard studio configuration, the main
outs are intended for a pair of studio monitors.
However, if you are using the MOTU 828 in other
ways, such as in a live performance situation, you
could use the main outs for stage monitors while
outputs 1 and 2 are used for the PA.
Using an external mixer
The MOTU 828 can be used without a mixing
board, as shown on the opposite page in
Figure 3-3. In this setup, all mixing and effects
processing occurs in the audio software running on
the computer.
If you’d like to use external mixing, see “Using the
MOTU 828 with a mixer” on page 18.

Figure 3-2: the MOTU 828 rear panel.
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A TYPICAL STUDIO SETUP (NO MIXER)
Here is a typical MOTU 828 studio setup. This rig
can be operated without an external mixer. All
mixing and processing can be done in the
computer with audio software. During recording,
you can use the MOTU 828’s CueMix™ Plus no-

latency monitoring to listen to what you are
recording via the main outs. The MOTU 828
Control Panel software lets you choose the input
(or input pair) that you wish to monitor. Guitar can
be processed with plug-ins on the computer, or
with an amp.

foot
switch
guitar
(with or without amp)
Mac

sends to
FX unit
(in rack
below)

other outputs
(stage
monitors,
etc.)
mic

FireWire

headphones

Headphone jack
(on front panel)

monitors
ADAT optical

ADAT

S/PDIF

quarter-inch analog outs

DAT deck

synthesizer
quarter-inch analog outs

synths, samplers, effects units, etc.

Figure 3-3: A typical MOTU 828 studio setup.
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USING THE MOTU 828 WITH A MIXER
While there are many ways to use the MOTU 828
with an external mixer, typically the MOTU 828
serves as a multi-channel “pipeline” between the
mixer and the computer. If your mixer is analog,
connect the analog section of the MOTU 828 to
your mixer. If your mixer is digital, and it has
ADAT optical I/O, you can connect them optically
as shown below in Figure 3-4. The MOTU 828’s

available analog and S/PDIF inputs and outputs
can serve as an extension to the mixer I/O, but then
you will probably find yourself mixing in two
places: the mixer and the computer. A word of
advice: if you would like to use the MOTU 828 with
an external mixer, use the mixer for mixing. Trying
to mix large multitrack projects in two places can
become very cumbersome very quickly.

Mac

FireWire

8-channel digital I/O

ADAT optical

synths, samplers, etc.

synthesizers
digital mixer

Figure 3-4: Using the MOTU 828 with a digital mixer.
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MAKING SYNC CONNECTIONS
If you connect devices digitally to the MOTU 828,
or if you need to synchronize the MOTU 828 with
an outside time reference such as SMPTE time
code, you must pay careful attention to the
synchronization connections and clock source
issues discussed in the next few sections.
Do you need to synchronize the MOTU 828?
If you will be using only the MOTU 828’s analog
inputs and outputs (and none of its digital I/O),
and you have no plans to synchronize your MOTU
828 system to SMPTE time code, you don’t need to
make any sync connections. You can skip this
section and proceed to chapter 4, “Installing the
MOTU 828 Macintosh Software” (page 29). After
you install the MOTU 828 software, you’ll open the
MOTU 828 Control Panel and set the Clock Source
setting to Internal as shown below in Figure 3-5.
For details, see chapter 5, “MOTU 828 Control
Panel” (page 33).

Figure 3-5: You can run the MOTU 828 under its own internal clock
when it has no digital audio connections and you are not synchronizing the MOTU 828 system to an external time reference such as
SMPTE time code.

Synchronization is critical for clean digital I/O
Synchronization is critical in any audio system, but
it is especially important when you are transferring
audio between digital audio devices. Your success
in using the MOTU 828’s digital I/O features
depends almost entirely on proper synchronization. The following sections guide you through
several recommended scenarios.
Be sure to choose a digital audio clock master
When you transfer digital audio between two
devices, their audio clocks must be in phase with
one another — or phase-locked. Otherwise, you’ll
hear clicks, pops, and distortion in the audio — or
perhaps no audio at all.
Not phase-locked

Phase-locked

Device A
Device B
Figure 3-6: When transferring audio, two devices must have phaselocked audio clocks to prevent clicks, pops or other artifacts.

There are two ways to achieve phase lock: slave one
device to the other, or slave both devices to a third
master clock. If you have three or more digital
audio devices, you need to slave them all to a single
master audio clock.

Master

Situations that require synchronization
There are three general cases in which you will
need to synchronize the MOTU 828 with other
devices:
■ Synchronizing the MOTU 828 with other digital
audio devices so that their digital audio clocks are
phase-locked (as shown in Figure 3-6)
■ Slaving the MOTU 828 system to SMPTE time
code, such as from a video deck or an analog multitrack tape recorder
■

Both of the above

Slave

Master

Slave

Slave

Figure 3-7: To keep the MOTU 828 phased-locked with other digital
audio devices connected to it, choose a clock master.

Also remember that audio phase lock can be
achieved independently of time code (location).
For example, one device can be the time code
master while another is the audio clock master. But
only one device can be the audio clock master. If
you set things up with this rule in mind, you’ll have
trouble-free audio transfers with the MOTU 828.
19
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DO YOU NEED A SYNCHRONIZER?
Whether or not you’ll need a synchronizer depends
on your gear and what you will be doing with your
MOTU 828 system. The following pages give you
specific information about common sync
scenarios. At least one of them will likely apply to
you. Here are some general considerations to help
you figure out if you need (or want) a synchronizer
for you MOTU 828 system.

compatible synchronizer such as MOTU’s MIDI
Timepiece AV, as discussed in “Sample-accurate
sync” on page 21. If you are simply using the ADAT
as a backup medium where you transfer eight
tracks at a time and don’t care about their exact
location, no synchronizer is required. You can
simply slave the ADAT to the optical output from
the MOTU 828 as explained in “Syncing optical
devices” on page 25.

You don’t need a synchronizer if...
As explained earlier, the MOTU 828’s digital audio
clock must be phase-locked (synchronized) with
other connected digital audio devices to achieve
clean digital transfers between them. Can this be
accomplished without an additional digital audio
synchronizer? It depends on the nature of the other
devices, and what you want to do with them. You
don’t need a synchronizer if the device has a way of
locking itself directly to the MOTU 828’s clock (via
ADAT lightpipe or S/PDIF), AND if the device
carries no sense of location in time. A digital mixer
is a good example: it can slave to its ADAT lightpipe
connection from the MOTU 828, and it has no
sense of time; it just passes audio through for
mixing.

Transport control from your computer
If you have ADATs or other digital recording
devices connected to the MOTU 828, your audio
software — if it supports MIDI Machine Control
(MMC) — allows you to control the transports of
everything from your computer. Most advanced
audio programs support MMC. To do this, you’ll
also need an MMC-compatible ADAT
synchronizer such as a MOTU MIDI Timepiece AV
or Digital Timepiece. Synchronizers like these
allow you to play, stop, rewind and locate all of your
tape decks using the transport controls in the audio
software. If your audio software supports ASIO 2,
you can do so with sample-accurate precision. The
following pages show you how to achieve MMC
control, where possible.

An ADAT, on the other hand, does have a sense of
location in time, either via SMPTE time code or via
its own sample address time format (ABS). If you
want to fly tracks back and forth between your
computer and ADAT tapes while maintaining the
audio’s position in time, the ADAT SYNC port on
the MOTU 828 lets you do so without a separate
synchronizer — and with sample-accurate
precision (if you’re using AudioDesk, Digital
Performer, or an ASIO 2.0-compatible program
that supports sample-accurate sync). Just connect
the MOTU 828 directly to the ADAT as discussed
in “ADAT sync with no synchronizer” on page 23.
But if you also want transport control over the
entire rig (including the ADAT) from your audio
software, you’ll need a MIDI Machine Control-

Continuous sync to SMPTE / MTC
If you need to synchronize the MOTU 828 (and
your audio software) to SMPTE time code, this
requires a dedicated synchronizer, which
continuously resolves the MOTU 828 to SMPTE
time code, while simultaneously resolving your
audio software to MIDI Time Code. When the
MOTU 828 is continuously resolved, audio
playback will never drift with respect to the time
code. Again, the MOTU MIDI Timepiece AV and
Digital Timepiece are affordable examples of this
type of synchronizer. The following pages illustrate
how to set up this type of synchronization with
various kinds of gear. Regardless of the specific
equipment you have, you can follow the basic
connections shown.
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SAMPLE-ACCURATE SYNC
Your MOTU 828 system provides you with the
most advanced, accurate synchronization possible
with Alesis ADATs (Type I and II) or any device
that supports ADAT sync. Figure 3-8 below shows
a few best-case scenarios for syncing the MOTU
828 with ADATs (in ABS time). Below is a brief
explanation of the benefits you achieve with these
setups.
Sample accurate locating
With sample accurate locating, when you transfer
audio between AudioDesk (or any other sampleaccurate host software such as Digital Performer)
and ADATs, the audio will not drift in time — even
by as little as one sample. This is the tightest
possible synchronization between digital audio
devices. The timing in your audio will not be
affected in any way by the process of transferring it
between the MOTU 828 and your ADATs. Sampleaccurate locating is only possible with software that
supports this feature, such as AudioDesk, Digital
Performer, Cubase VST or other ASIO 2
compatible audio software.

Transport control from your computer
If you have a MIDI Timepiece AV, Digital
Timepiece or any ADAT synchronizer that also
supports MIDI Machine Control (MMC), you can
play, stop, rewind and locate all of your ADATs
using the transport controls in the audio software
running on your computer. This includes cueing
features like markers, position bars, playback
wipers, time rulers, etc.
Continuous sync to SMPTE / MTC
This means that the MOTU 828 can be
continuously resolved to SMPTE time code (or
MIDI Time Code) via a dedicated synchronizer,
such as the MIDI Timepiece AV. When the MOTU
828 is continuously resolved, audio playback will
never drift with respect to time code.

Figure 3-9: AudioDesk and Digital Performer support sampleaccurate transfers with ADATs.

Tape recorder/
Sync format

Sample
accurate
locating

Transport
control
from computer

Continuous sync
to SMPTE / MTC

Software

Synchronizer

ADAT

AudioDesk, Cubase VST
or Digital Performer

MIDI Timepiece AV
or Digital Timepiece

Yes

Yes

Yes

ADAT

AudioDesk, Cubase VST
or Digital Performer

BRC (or any MMC capable ADAT synchronizer)

Yes

Yes

Yes

ADAT

AudioDesk, Cubase VST
or Digital Performer

None

Yes

No

No

Figure 3-8: These recommended combinations of hardware and software offer the tightest sync possible between the MOTU 828 and digital
audio tape decks in the form of sample-accurate locating between the software and the tape decks. Sample accurate locating is possible with
ADATs even without a MIDI Timepiece AV or Digital Timepiece, although you give up transport control from the computer without them.
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SAMPLE-ACCURATE SYNC WITH ADATs

What this setup provides

The MOTU 828 can achieve sample-accurate sync
with AudioDesk, Digital Performer, or any ASIO
2.0-compatible audio software that also supports
sample-accurate sync. Connect the MOTU 828 to
the end of the ADAT chain and make the software
settings shown below in Figure 3-10. If you will be
using the ADAT for its analog inputs and outputs
only (you won’t be using any tapes in the ADAT),
treat it as an ‘optical’ device. See “Syncing optical
devices” on page 25.

✓ Sample-accurate locating between all ADATs, the MOTU
828, and AudioDesk or Digital Performer.

✓ Transport control of everything from the computer.
OR

✓ Continuous sync to SMPTE time code and other sync sources
(the other source is the transport master in this case).

In AudioDesk or Digital Performer:
1. Choose Receive Sync the Basics
menu.
2. Choose the Sample-accurate
option shown to the left.
To set the MOTU 828 hardware clock source for
sample-accurate sync:

Macintosh computer running
AudioDesk or Digital Performer

1. Choose MOTU Audio System>Configure
Hardware Driver from the Basics menu in
AudioDesk or Digital Performer, or run the MOTU
828 Control Panel.

USB or serial cable (bi-directional MIDI
connection) bearing MMC transport
commands from AudioDesk or
Digital Performer to the
MIDI Timepiece AV (or other synchronizer)

FireWire

2. Choose ADAT 9-pin from the Clock Source menu
as shown to above.

Digital Timepiece, MIDI
Timepiece AV, Alesis BRC or
any other MMC-compatible
ADAT synchronizer
If you have a MOTU
synchronizer, set its
sync mode to Internal.

3. Make sure the Sample Rate setting matches the
tape decks and synchronizer.
For sample-accurate sync settings in Cubase VST, see
“Sample-accurate sync to ADAT” on page 57.

ADAT
Sync Out

ADATs
ADAT
Sync In sync cables
Sync Out
Sync In
Sync Out
Sync In
Sync Out

etc.

AudioDesk automatically scans the
DTP or MTP AV for ADATs, and they
appear here. Just make sure you
have the DTP or MTP AV in your
FreeMIDI setup.

In AudioDesk or Digital
Performer, turn on MIDI
Machine Control by
pressing this button (to
make the arrow black).
This brings on line all the
tape decks connected to
the DTP or MTP AV.

The above is also
true for any version
of Digital Performer
later than 2.42.
(The MOTU 828
requires Version
2.42 or higher.)

FireWire
Sync In

Figure 3-10: Connections for sample-accurate sync between one or more ADATs and the MOTU 828.
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ADAT SYNC WITH NO SYNCHRONIZER
Even if you don’t have an ADAT synchronizer, you
can achieve sample-accurate sync between ADATs,
the MOTU 828, and any sample-accurate software
(such as AudioDesk or Digital Performer). Just
connect the MOTU 828 to the end of the ADAT
sync chain as shown below. But without the
synchronizer, you don’t get transport control from
your computer, nor can you slave the system to
external SMPTE time code. Instead, you have to
play, stop, rewind and cue the system from the
transports on your ADAT (or via an Alesis LRC). If

you will be using the ADAT for its analog inputs
and outputs only (you won’t be using any tapes in
the ADAT), treat it as an ‘optical’ device. See
“Syncing optical devices” on page 25.
What this setup provides

✓

Sample-accurate locating between all ADATs, the MOTU
828, and AudioDesk or Digital Performer.

✗

No transport control of everything from the computer

✗

No continuous sync to SMPTE time code and other sources

In AudioDesk or Digital Performer:
1. Choose Receive Sync from the
Basics menu.
2. Choose the Sample-accurate
option shown to the left.

To set the MOTU 828 hardware clock source for sample-accurate sync:
1. Choose MOTU Audio System>Configure Hardware Driver from the
Basics menu in AudioDesk or Digital Performer, or run the MOTU 828
Control Panel.

Macintosh computer running
AudioDesk or Digital Performer

2. Choose ADAT 9-pin from the Clock Source menu as shown to above.
3. Make sure the Sample Rate setting matches the tape decks and
synchronizer.
In AudioDesk or Digital Performer:
With no synchronizer, the ADAT that is the
master of the ADAT sync chain becomes
transport master over everything, including your audio software.

FireWire

1. Make sure that Slave to External Sync is checked in the Basics menu.
2. Click the play or record button. The software will then wait for you to
start your ADAT.
3. Press the Play button on the front panel of your ADAT to initiate
playback or recording.

ADATs

Sync Out
Sync In
Sync Out

ADAT
sync cables

Sync In
Sync Out

etc.

FireWire
Sync In

For sample-accurate sync settings in Cubase VST, see
“Sample-accurate sync to ADAT” on page 57.

Figure 3-11: Sample-accurate sync between AudioDesk or Digital Performer
and one or more ADATs — without an ADAT synchronizer.
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SYNC TO SMPTE, WORD CLOCK, VIDEO
To synchronize (continuously resolve) the
MOTU 828 with SMPTE time code, word clock,
video or blackburst, you will need a MOTU Digital
Timepiece, MIDI Timepiece AV or any other
universal synchronizer equipped with ADAT sync.
The synchronizer resolves continuously to the
chosen time base, and the MOTU 828 slaves to the
synchronizer via ADAT Sync. In addition, the
audio software running on the computer slaves to
MIDI Time Code generated by the synchronizer.
How accurate will transfers be between your audio
software and other audio devices? As good as the
resolution of MIDI time code, which — at 30 fps —
provides quarter frame resolution of 120th of a

second (367 samples at 44.1 KHz). But if you are
running your synchronizer under its own internal
clock (triggering it via MMC from your software),
you will probably get even tighter timing than that
— perhaps as good as ±50 samples.
What this setup provides

✗

No sample-accurate locating

✓
✗

Timing accuracy that is at least as good as MIDI time code
(quarter-frame)— and maybe even tighter
No transport control of from the computer

✓

Continuous sync to SMPTE time code and other sync sources
(the other source is the transport master in this case)

In AudioDesk or Digital Performer:
1. Choose Receive Sync from the
Basics menu.

Video deck generating
video and SMPTE

2. Choose the SMPTE time code
option shown to the left.

To set the MOTU 828 hardware clock source for
resolving the MOTU 828 to a synchronizer:
Macintosh computer running
AudioDesk or Digital Performer

USB or serial cable sending
MIDI Time Code to AudioDesk
or Digital Performer from the
MIDI Timepiece AV (or other
synchronizer)

SMPTE
time code
and
video

MOTU Digital Timepiece,
MIDI Timepiece AV or any other
ADAT-compatible synchronizer

FireWire

Sync In
Sync Out

FireWire
Sync In

2. Choose ADAT 9-pin from the Clock Source
menu as shown to above.
3. Make sure the Sample Rate setting matches
the tape decks and synchronizer.

In AudioDesk or Digital Performer:
1. Make sure that Slave to External Sync is
checked in the Basics menu.

ADAT
Sync Out
ADAT

1. Choose MOTU Audio System>Configure
Hardware Driver from the Basics menu in
AudioDesk or Digital Performer, or run the
MOTU 828 Control Panel.

2. Click the play or record button. The software
will then wait for you to start your video
deck or other master sync source.
Having one or
more ADATs in
the sync chain
is optional.

ADAT
sync cable

Figure 3-12: Resolving the MOTU 828 to an external time base, such as SMPTE time code, word clock, or video. In this
example, an S-VHS video deck is supplying SMPTE time code (address) and video (as the time base). For examples of
other sources, consult the MIDI Timepiece AV manual (or other synchronizer).
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SYNCING OPTICAL DEVICES

For ADATs or other devices that support ADAT
sync, synchronize them with the MOTU 828 as
described in the previous sections of this chapter.

The word optical is our short-hand way of referring
to any device that connects to the MOTU 828 via
an optical cable. But we make a further distinction:
an optical device is also one that doesn’t care about
sample location. An example is a digital mixer.
Since a digital mixer is not a recording device, it has
no sense of sample location like an ADAT does. An
ADAT can cue to a specific sample number (e.g.
sample number 43,478, 103) — as can any device
that supports ADAT sync, but most digital mixers
simply mix and process audio digitally, with no
sense of a specific sample location. There are many
other devices that fall into this category, including
digital effects processors, synthesizers, A/D
converters, and many more.

For optical devices, such as digital mixers, all you
have to do is make sure that their digital audio
clock is phase-locked (in sync with) the MOTU
828. There are three ways to do this:
■

Slave the optical device to the MOTU 828

■

Slave the MOTU 828 to the optical device

■ Slave both the optical device and the MOTU 828
to a third master clock (such as a Digital Timepiece
or MIDI Timepiece AV synchronizer)

Digital mixer
or other optical
device

MOTU 828
ADAT Optical OUT

With this setup, in the MOTU 828
Control Panel, choose the Optical
clock source setting. The MOTU
828 slaves to the optical device via
their optical cable connection.
ADAT Optical OUT

ADAT Optical IN
Digital mixer
or other optical
device

ADAT Optical IN

MOTU 828
Clock Source setting =
optical

MOTU 828

MOTU 828
Clock Source setting =
Internal, or any clock source
setting except Optical. The optical
device slaves to the MOTU 828 (via
its optical cable connection).

MIDI Timepiece AV
set to Internal

Digital mixer
or other optical
device

Word Clock Out

MOTU 828
Clock Source setting =
ADAT 9-pin

ADAT Sync out

Mac

Word Clock IN
ADAT sync in
bi-directional
optical

Computer with MOTU 828

Figure 3-13: Three setups for synchronizing an optical device with the MOTU 828. You can slave the optical device to the MOTU 828 or vice
versa with their optical connections. For more elaborate setups, you can slave both to a digital audio synchronizer like the Digital Timepiece.
Don’t use any of these setups for an ADAT or other optical device that records. Instead, see “Sample-accurate sync with ADATs” on page 22.
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SYNCING S/PDIF DEVICES
DAT decks and other S/PDIF devices will sync to
the MOTU 828 in one of two ways:
■

Via the S/PDIF connection itself

■

Via word clock

S/PDIF devices with no word clock
If your DAT deck or other S/PDIF device has no
word clock sync connectors, just connect it to the
MOTU 828 via the S/PDIF connectors. When the
device records S/PDIF audio (from the MOTU
828), it will simply synchronize to the clock
provided by the audio input.

MOTU 828
S/PDIF

On the other hand, when you transfer audio from
the S/PDIF device into the MOTU 828, you’ll have
to slave the MOTU 828 to its S/PDIF input. If you
have other digital audio devices connected to the
MOTU 828, and they are not slaved directly to the
MOTU 828 itself, you may hear clicks and pops
resulting from their unsynchronized audio clock. If
so, just turn them off during the transfer.
S/PDIF devices with word clock
If your S/PDIF device has a Word Clock input, slave
both the S/PDIF device and the MOTU 828 to a
MOTU MIDI Timepiece AV (or other synchronizer). You can then freely transfer audio between
the MOTU 828 and the S/PDIF device.

MOTU 828
Clock Source setting =
Internal (when transferring from the
MOTU 828 to the S/PDIF device)

MOTU 828
Clock Source setting =
S/PDIF (when transferring from
the S/PDIF device to the MOTU 828)

S/PDIF
DAT deck
or other S/PDIF device

MIDI Timepiece AV
set to Internal

Word Clock Out

MOTU 828
Clock Source setting =
ADAT 9-pin

ADAT Sync out

Mac
Word Clock IN
ADAT sync in
DAT deck
or other S/PDIF device

S/PDIF

Computer with MOTU 828

Figure 3-14: Two setups for synchronizing an S/PDIF device with the MOTU 828. In the top diagram, sync is achieved via the S/PDIF connection
itself. In this case, you have to choose S/PDIF as the MOTU 828’s clock source when recording from the S/PDIF device. If you don’t want to have to
worry about switching the Clock Source setting depending on the direction of the S/PDIF transfer, you can slave the S/PDIF device to word clock
from the MOTU 828 or vice versa (not shown). The Word Clock connection maintains sync, regardless of the direction of the transfer.
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SYNCING LARGE SYSTEMS
If you are connecting the MOTU 828 to a lot of
other digital audio gear, get a Digital Timepiece. It
can synchronize a wide variety of devices, and it
offers sample accurate synchronization for devices
that support it, such as ADATs. You will also be able
to control everything from the transport controls
of your audio software. If you have even more
devices than a single Digital Timepiece can
support, consider a word clock distribution device,
such as the Aardvark Aard Sync™ video-to-word
clock converter. Products like this offer multiple
word clock outputs and an extremely low-jitter
clock.
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CHAPTER 4

Installing the MOTU 828 Macintosh
Software

OVERVIEW

Running the MOTU 828 software installer . . . . 30

The MOTU 828 ships with the following software
components:

MOTU 828 Driver and Enabler . . . . . . . . . . . . . . 30

Software
component

Location

Purpose

MOTU 828 Control Panel . . . . . . . . . . . . . . . . . . . 30

MOTU 828
Driver

Extensions
Folder

Allow the MOTU 828 to
establish communication with the computer.

MOTU 828
Enabler

MOTU Folder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
MOTU 828 Control strip module . . . . . . . . . . . . 30
AudioDesk workstation software . . . . . . . . . . . . 31
ASIO MOTU 828 Driver . . . . . . . . . . . . . . . . . . . . 31

MOTU
Folder

Extensions
Folder

Contains the MOTU
hard disk recording
engine. Required for
MOTU 828 operation
with AudioDesk and
Digital Performer.

MOTU 828
Control Panel

Apple menu
(Control Panels
Folder)

Provides access to all of
the settings in the
MOTU 828 hardware.

MOTU 828
Control Strip

Control Strip
(Control Strip
Modules
Folder)

Provides access to all of
the settings in the
MOTU 828 hardware.

AudioDesk
Workstation
Software

Top level of the
startup disk

Provides complete
multi-track recording,
mixing and processing.
Optional.

ASIO MOTU 828

In the ASIO
Drivers folder of
your audio software—other
than AudioDesk
or Digital Performer

Allows ASIO-compliant
audio software to do
multi-channel input and
output with the MOTU
828. Only required if you
are using Cubase VST or
another ASIO-compatible program.

AudioDesk
Demo Project

Anywhere you
want

Provides a multi-track
mix that you can open,
play, and mix in
AudioDesk. Optional.
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RUNNING THE MOTU 828 SOFTWARE
INSTALLER
Insert the Macintosh and Windows compatible
installer CD-ROM into your Macintosh and run
the MOTU Audio/AudioDesk installer on the CD.
It will guide you through the installation. If you are
unsure about what components to install, refer to
the rest of the sections in this chapter, which
explain the purpose of each software item.

MOTU 828 CONTROL PANEL
The MOTU 828 Control Panel is placed by the
installer in your Mac’s Apple menu (under Control
Panels). It gives you access to all of the settings in
the MOTU 828 hardware, such as the sample rate.
For complete details, see chapter 5, “MOTU 828
Control Panel” (page 33).

MOTU 828 DRIVER AND ENABLER
These two MacOS System Extensions allow the
MOTU 828 to communicate with the computer.
They must always be enabled in your extension set,
along with any MacOS FireWire system extensions.

MOTU FOLDER
The MOTU Folder goes in the Extensions Folder
inside the System Folder on the Macintosh startup
disk.
The MOTU Folder contains the hard disk
recording engine for AudioDesk and Digital
Performer. It also holds the real-time effects
processing plug-ins used by AudioDesk and Digital
Performer.

Figure 4-2: The MOTU 828 Control Panel gives you access to all of the
settings in the MOTU 828 hardware.

MOTU 828 CONTROL STRIP MODULE
The MOTU 828 Control Strip module is placed by
the installer in your Mac’s Control Strip. Just like
the MOTU 828 Control Panel, it gives you access to
all of the settings in the MOTU 828 hardware. For
complete details, see chapter 5, “MOTU 828
Control Panel” (page 33).

Figure 4-1: The MOTU Folder contains the MOTU hard disk recording
engine for AudioDesk and Digital Performer.

Figure 4-3: The MOTU 828 Control Strip module gives you access to all
of the settings in the MOTU 828 hardware, just like the MOTU 828
Control Panel.
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AUDIODESK WORKSTATION SOFTWARE

ASIO MOTU 828 DRIVER

The MOTU 828 installer places AudioDesk on the
top level of your Macintosh’s startup volume.

ASIO stands for Audio Streaming Input and Output.
The ASIO MOTU 828 driver allows MOTU 828 to
provide multi-channel input and output for
Steinberg’s Cubase VST software, or any other
audio application that supports ASIO drivers.

AudioDesk is an advanced workstation software
package for the MOTU 828 that lets you record,
edit, mix, process, bounce and master multi-track
digital audio recording projects. Advanced features
include real-time 32-bit effects processing, sampleaccurate synchronization with ADATs, 24-bit
recording, and much more.
See the AudioDesk manual included with your
MOTU 828 system for details.

The ASIO MOTU 828 driver is only required if you
are using Cubase VST (or another audio program
that relies on the ASIO driver to support multichannel I/O with the MOTU 828).

☛

Digital Performer and AudioDesk support
ASIO, but they also access the MOTU 828 directly
through the MOTU Audio System, so it is not
necessary to use the ASIO driver with these MOTU
applications.
The ASIO MOTU 828 driver should be placed in
the ASIO folder of Cubase VST or other ASIOcompliant software that you are running as the
software “front end” for the MOTU 828.
For details about using Cubase VST with the
MOTU 828, see chapter 8, “The MOTU 828 and
Other Audio Software” (page 53).

Figure 4-4: AudioDesk.

Figure 4-5: The ASIO MOTU 828 Driver.
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CHAPTER 5

MOTU 828 Control Panel

OVERVIEW

ACCESSING THE MOTU 828 SETTINGS

The MOTU 828 Control Panel provides access to
all MOTU 828 settings. These settings can also be
accessed from the MOTU 828 Control Strip
module or from the Configure Hardware Driver
command in AudioDesk or Digital Performer
(Basics menu).

There are several ways to access the MOTU 828
Control Panel settings:

Accessing the MOTU 828 settings . . . . . . . . . . . .33

■ From the Apple menu, choose the MOTU 828
Control Panel
■ From the MacOS control strip, click on the
MOTU 828 Control Strip Module

MOTU 828 Settings . . . . . . . . . . . . . . . . . . . . . . . .34
Sample Rate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .34
Clock Source . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .34
Samples Per Buffer . . . . . . . . . . . . . . . . . . . . . . . . .36
Optical input/output . . . . . . . . . . . . . . . . . . . . . . .37
Monitor input — CueMix™ Plus . . . . . . . . . . . . .37
Enable Sound Manager driver . . . . . . . . . . . . . . .37

■ From within AudioDesk™ or Digital
Performer™, choose Basics menu>MOTU Audio
System options>Configure Hardware Driver

Enable Pedal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .37
Monitoring live input . . . . . . . . . . . . . . . . . . . . . . .38
If MOTU 828 settings are grayed out . . . . . . . . .39

■ From within Cubase (Version 5 or higher), click
the ASIO Control Panel button in the System Setup
dialog as shown in Figure 8-3 on page 55.

From within other ASIO-compatible programs,
refer to their documentation.
■

It doesn’t matter which way you access the MOTU
828 settings. They are the same in all three places.
33

!828 Manual/Mac Page 34 Thursday, March 1, 2001 9:46 AM

MOTU 828 SETTINGS

Internal
Use the Internal setting when you want the MOTU
828 to operate under its own digital audio clock.
For example, you may be in a situation where all
you are doing is playing tracks off hard disk in your
digital audio software on the computer. In a
situation like this, you most often don’t need to
reference an external clock of any kind.
Another example is transferring a mix to DAT. You
can operate the MOTU 828 system on its internal
clock, and then slave the DAT deck to the MOTU
828 via the S/PDIF connection (usually DAT decks
slave to their S/DIF input when you choose the
S/PDIF input as their record source).

Figure 5-1: The MOTU 828 Control Panel gives you access to all of the
settings in the MOTU 828 hardware.

Sample Rate
Choose the desired Sample Rate for recording and
playback. The MOTU 828 can operate at either
44.1 KHz (the standard rate for compact disc
audio) or 48 KHz. Make absolutely sure that all of
the devices connected digitally to the MOTU 828
match the MOTU 828’s sample rate. Also make
sure that your Digital Timepiece, MIDI
Timepiece AV or other digital audio synchronizer
matches it as well.

☛

Mismatched sample rates cause distortion and
crackling. If you hear this sort of thing, check the
sample rate settings in your hardware and here in
the MOTU 828 Control Panel.
Clock Source
The Clock Source determines the digital audio clock
that the MOTU 828 will use as its time base. For a
complete explanation of synchronization issues,
see “Making sync connections” on page 19. The
following sections briefly discuss each clock source
setting.

If you would like help determining if this is the
proper clock setting for your situation, see “Do you
need a synchronizer?” on page 20.
With ADAT devices, however, you usually want an
external digital audio synchronizer, such as the
MIDI Timepiece AV or Digital Timepiece, to be the
digital clock master. In this case, you would set the
MOTU 828 clock source setting to ADAT 9-pin, as
described below.
ADAT 9-pin
The ADAT 9-pin clock source setting refers to the
ADAT digital audio synchronization format. It
allows the MOTU 828 to slave to an ADAT — or
ADAT sync chain — via its ADAT sync 9-pin
connector. ADAT sync also carries precise, sample
location information, which allows AudioDesk and
Digital Performer to transfer audio to and from
ADATs without drifting by as much as one sample.
Use this setting when you are using the MOTU 828
with one or more ADATs. Make sure the MOTU
828 is connected to the end of the ADAT sync
chain.
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You should also use this setting if you have a MIDI
Timepiece AV, which allows you to drive your
entire system from the transport controls of
AudioDesk, Digital Performer or other computer
software.
ADAT sync also allows you to continuously resolve
the MOTU 828 to SMPTE time code, video, and
word clock via a synchronizer like the MOTU
MIDI Timepiece AV.
For further details, see “Sample-accurate sync with
ADATs” on page 22, “ADAT sync with no
synchronizer” on page 23 and “Sync to SMPTE,
word clock, video” on page 24.
ADAT optical
The ADAT optical clock source setting refers to the
clock provided by the MOTU 828’s optical input,
when it is connected to an ADAT optical device.
This setting can be used to slave the MOTU 828
directly to the optical input connection. Most of
the time, you can set up a better operating scenario
that uses one of the other synchronization options.
However, there may be occasions when you have an
ADAT optical compatible device that has no way of
synchronizing digitally to the MOTU 828 or an
external synchronizer such as the Digital
Timepiece. In this case, the ADAT Optical clock
source setting lets you slave the MOTU 828 to the
device itself via its digital input to the MOTU 828.
If the ADAT Optical setting does not appear in the
menu, it means that the MOTU 828’s optical input
is currently either turned off or set to the TOSLink
format. In either case, choose the ADAT optical
format from the Optical input menu (Figure 5-1 on
page 34).

code reference and shared transport control are not
needed — without having to set up an elaborate
synchronization scenario.
For further details about this setting, see “Syncing
optical devices” on page 25.
TOSLink
The TOSLink clock source setting refers to the
clock provided an optical S/PDIF device connected
to the MOTU 828’s optical input. This setting can
be used to slave the MOTU 828 directly to the
optical input connection. Most of the time, you can
set up a better operating scenario that uses one of
the other synchronization options. However, there
may be occasions when you have an TOSLinkcompatible device that has no way of
synchronizing digitally to the MOTU 828 or an
external synchronizer such as the Digital
Timepiece. In this case, the TOSLink clock source
setting lets you slave the MOTU 828 to the other
device via the MOTU 828’s optical input.
If the TOSLink setting does not appear in the menu,
it means that the MOTU 828’s optical input is
currently either turned off or set to the ADAT
optical format. In either case, choose the TOSLink
format from the Optical input menu (Figure 5-1 on
page 34).
This setting is also useful if you just need to make a
simple, click-free digital transfer between the
MOTU 828 and another device — where a time
code reference and shared transport control are not
needed — without having to set up an elaborate
synchronization scenario.
For further details about this setting, see “Syncing
optical devices” on page 25.

This setting is also useful if you just need to make a
simple, click-free digital transfer between the
MOTU 828 and another device — where a time
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S/PDIF
The S/PDIF clock source setting refers to the
S/PDIF RCA input connector on the MOTU 828.
This setting allows the MOTU 828 to slave to
another S/PDIF device.
Use this setting whenever you are recording input
from a DAT deck or other S/PDIF device into the
MOTU 828. It is not necessary in the opposite
direction (when you are transferring from the
MOTU 828 to the DAT machine).
If the S/PDIF setting does not appear in the menu,
it means that the MOTU 828’s optical input is
currently set to TOSLink. To make it appear again,
either disable the Optical input or switch it to the
ADAT optical format (Figure 5-1 on page 34).
For further details about this setting, see “Syncing
S/PDIF devices” on page 26.
Samples Per Buffer
A sample buffer is a small part of computer memory
that briefly holds digital audio samples as they are
passed between the computer and the MOTU 828.
The Samples Per Buffer setting lets you control the
size of these buffers in the MOTU 828 driver. A
higher setting reduces the processing load on your
computer; a lower setting reduces monitoring
latency, which is the slight delay you hear when
patching live audio through the MOTU 828 and
your audio software. (See “Monitoring live input”
on page 38 for further explanation.) For example,
you might want to listen to the vocals you are
recording with a little bit of reverb on them from a
plug-in in your audio software. The signal that gets
recorded to disk is ‘dry’, but the signal in your
headphones is ‘wet’. Since the vocal material
recorded to disk is dry, you then have the flexibility
to apply real-time reverb to the track after
recording and change it at any time (since the

reverb is not ‘printed’ in the track). You can even
automate changes to plug-in effects over time (if
your software supports plug-in automation).
A Samples Per Buffer setting of 512 produces a
round-trip delay (monitoring latency) of
approximately 23 milliseconds (ms). A setting of
256 produces monitoring latency of around
12-13 ms, and the delay starts to become inaudible.
Monitoring latency has no effect on recording
It is important to note that monitoring latency only
applies to the live signal as it is being monitored. It
has no effect whatsoever on the timing accuracy of
the material being recorded to hard disk. The
system is precisely calibrated to record and play
back hard disk audio perfectly on time.
Choosing the right ‘Samples per buffer’ setting
If you would like to process live inputs with plug-in
effects in your software (such as putting a reverb
plug-in on a vocal mic input or a guitar amp
simulation plug-in on your guitar signal), make the
Samples Per Buffer setting as low as possible. How
low you can go depends on how fast your computer
is and how much plug-in processing (and other
processor-intensive tasks) you are using in your
recording project. Try settings below 512 and if
your computer begins to act sluggish, try raising
them again to the next highest buffer setting until
the computer feels responsive. If your computer
doesn’t allow you to go low enough, try cueMix™
Plus monitoring (“Monitor input — CueMix™
Plus” below) and then apply plug-in processing to
the disk track after it has been recorded.
Changing the ‘Samples Per Buffer’ setting
If you are at a point in your recording project where
you are not currently working with live, patchedthru material (e.g. you’re not recording vocals),
switch to a higher Samples Per Buffer setting.
Depending on your computer’s CPU speed, you
might find that settings in the middle work best
and that your computer is much more responsive.
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CueMix ™Plus monitoring
The MOTU 828’s CueMix™ Plus no-latency
monitoring feature completely eliminates
monitoring latency. For further information, see
“Monitoring live input” on page 38.
Optical input/output
The Optical input and Optical output settings let
you choose between ADAT optical (‘lightpipe’) and
S/PDIF optical (‘TOSLink’) as the format for the
MOTU 828’s optical input and output. Choose the
format that matches the device connected. If you
are not using the optical connections, it is
recommended that you turn them off (as provided
in the menus) to reduce bandwidth and processing
overhead. Note that you can operate the input and
output independently. For example, you could use
the ADAT optical format on the input (with a
digital mixer, for example) and optical S/PDIF on
the output (with a DAT deck, for example).
Monitor input — CueMix™ Plus
The Monitor input settings enables the MOTU 828
CueMix™ Plus feature (Figure 5-3 on page 39),
which lets you route a single analog input or input
pair directly to the MOTU 828 main outs, where it
is mixed with the signal on the main outs. Routing
occurs with virtually no monitoring latency
(audible delay), and the signal is passed through
dry (with no signal processing of any kind). In

addition, the CueMix Plus signal volume can be
controlled (relative to the main mix volume) with
the Monitor knob on the MOTU 828 front panel.
For information about other ways to handle input
monitoring, see “Monitoring live input” on
page 38.
Enable Sound Manager driver
Check the Enable Sound Manager option if you
would like to route Sound Manager audio to and
from the MOTU 828. For example, you could listen
to an audio CD playing in the CD drive of your
Macintosh through headphones connected to the
MOTU 828. As another example, you could route
audio from a pair of MOTU 828 inputs into a thirdparty Sound Manager-compatible audio
application. Use the menus provided to choose the
desired MOTU 828 inputs and outputs you would
like to route to/from Sound Manager. For further
details, see chapter 9, “Sound Manager” (page 59).
Enable Pedal
Check the Enable Pedal option if a foot switch is
connected to the MOTU 828 and you would like to
trigger recording punch in/out (or other software
functions) with it. Use the Set buttons to determine
what keystroke is trigger by the pedal-up and
pedal-down positions. You can assign the pedal to
any two keystrokes you wish. (You are not
restricted to punch in/out.)
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MONITORING LIVE INPUT
There are two ways to monitor live audio input with
the MOTU 828: 1) through the computer or 2) via
CueMix™ Plus hardware monitoring. Figure 5-2
below shows method 1, which allows you to add
effects processing such as reverb and guitar amp
effects via plug-ins in your audio software. See
“Samples Per Buffer” on page 36 for details about
how to reduce — and possibly eliminate — the
audible monitoring delay that the computer
introduces.

If the material you are recording is suitable, there is
a third way to monitor live input: use both methods
(Figure 5-2 and Figure 5-3) at the same time. For
example, you could route vocals to both the
computer (for a bit of reverb) and mix that
processed signal on the main outs with dry vocals
from CueMix Plus.

Figure 5-3 shows how to use CueMix™ Plus
hardware-based monitoring, which lets you hear
what you are recording with no monitoring delay
and no computer-based effects processing. (You
can add effects later, after you’ve recorded the live
input as a disk track.) To learn more, see “Monitor
input — CueMix™ Plus” on page 37.

1. Live input (from mic, guitar, etc.)
enters the MOTU 828.

3. Mic signal is ‘patched
thru’ back to the MOTU
828 with reverb or other
plug-in effects, if any.

2. Mic signal goes immediately to the computer (dry,
with no effects processing).

4. Mic signal (with plug-in processing, if
any) is routed to the main outs (or other
MOTU 828 outputs that you’ve chosen in
your audio software).

Mac

Figure 5-2: There are two ways to monitor live audio inputs with the MOTU 828: 1) through the computer or 2) via CueMix™ Plus hardware
monitoring. This diagram shows method 1 (through the computer). When using this method, use the MOTU 828’s ‘Samples Per Buffer’ setting
to reduce the slight delay you hear when monitoring the live input, but don’t lower it too much, or your computer will act sluggish.
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IF MOTU 828 SETTINGS ARE GRAYED OUT
If the MOTU 828 FireWire driver is currently in use
by an audio program (or Sound Manager), some of
its settings cannot be changed and are therefore
grayed out in the MOTU 828 Control Panel menus.
(Settings that cannot be changed are ones on which
audio applications continuously depend for
smooth, error free operation.) If you find that a
MOTU 828 Control Panel setting that you wish to
change is grayed out, simply quit all MOTU 828compatible audio programs (which may include
Sound Manager-compatible programs, too, if you
are using the MOTU 828 with Sound Manager).
Once you have quite all applications, all MOTU 828
Control Panel settings will be available (not grayed
out).

1. Live input (from mic, guitar, etc.)
enters the MOTU 828.

2. CueMix™ Plus immediately patches the
live mic signal directly to the main outs,
completely bypassing the computer (dry,
with no effects processing).

3. Mic signal is mixed with the main outs,
and you can control the volume (relative to
the rest of the mix) with the ‘monitor’
knob on the front panel of the MOTU 828.

Figure 5-3: This diagram shows the signal flow when using CueMix™ Plus no-latency monitoring. Notice that this method does not allow you
to process the live input with plug-ins in your audio software while it is being monitored. You can, however, add effects later — after recording
the live input as a disk track. CueMix™ Plus lets you hear what you are recording with no delay and no computer-based effects.

39
MOTU 82 8 C O N TR O L P A N EL

!828 Manual/Mac Page 40 Thursday, March 1, 2001 9:46 AM

40
M O T U 8 2 8 C O NT R O L P ANE L

!828 Manual/Mac Page 41 Thursday, March 1, 2001 9:46 AM

CHAPTER 6

The MOTU 828 and Digital Performer

OVERVIEW

SETTING UP YOUR SYSTEM

This chapter provides a brief overview of Digital
Performer’s basic I/O and synchronization
operation with the MOTU 828 hardware. Digital
Performer Version 2.42 or higher is required for the
MOTU 828. Version 2.42 supports all of the
advanced features of the MOTU 828, including
sample-accurate synchronization with ADATs.

As described in chapter 4, “Installing the MOTU
828 Macintosh Software” (page 29), the Digital
Performer and MOTU 828/AudioDesk software
installers will properly install and update
everything for you.

Setting up your system. . . . . . . . . . . . . . . . . . . . . .41
The MOTU 828 settings. . . . . . . . . . . . . . . . . . . . .41
Be sure you have enough voices . . . . . . . . . . . . . .44
Trimming the analog inputs . . . . . . . . . . . . . . . . .44
24-bit operation. . . . . . . . . . . . . . . . . . . . . . . . . . . .44
Fine-tuning I/O timing . . . . . . . . . . . . . . . . . . . . .44
Synchronization . . . . . . . . . . . . . . . . . . . . . . . . . . .44
MIDI Machine Control (MMC) . . . . . . . . . . . . . .45
Reducing delay when monitoring live inputs . .45
Using a foot switch . . . . . . . . . . . . . . . . . . . . . . . . .45
Exchanging projects with AudioDesk. . . . . . . . .46
Sound Manager and Digital Performer . . . . . . .46

If you are using a MIDI Timepiece AV or Digital
Timepiece for synchronization, be sure they are
present in your FreeMIDI setup.

THE MOTU 828 SETTINGS
The MOTU 828 settings can be accessed by
choosing MOTU Audio System options>Configure
Hardware Driver from the Basics menu. If you don’t
see the MOTU 828 settings as shown below in
Figure 6-1, choose MOTU 828 from the menu at
the top of the Configure Hardware dialog. For
complete details about the important settings in
this window, see chapter 5, “MOTU 828 Control
Panel” (page 33).
The following sections provide a brief explanation
of each MOTU 828 setting for use with Digital
Performer. For a more complete overview, see
chapter 5, “MOTU 828 Control Panel” (page 33).
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Clock Source
This setting is very important because it
determines which audio clock the MOTU 828
system will follow.
If you do not have any digital audio connections to
your MOTU 828 (you are using the analog inputs
and outputs only), and you will not be slaving
Digital Performer to external SMPTE time code,
choose Internal.
If you are slaving the MOTU 828 to the ADAT sync
Input connector, choose ADAT 9-pin.
If you have digital audio devices connected to the
MOTU 828, or if you are not sure about the clock
source of your setup, be sure to read “Making sync
connections” on page 19 and “Clock Source” on
page 34.
Samples Per Buffer
The Samples Per Buffer setting can be used to
reduce the delay — or monitoring latency — that
you hear when live audio is patched through your
MOTU 828 hardware and Digital Performer. For
example, you might have MIDI instruments,
samplers, microphones, and so on connected to
the analog inputs of the MOTU 828. If so, you will
often be mixing their live input with audio material
recorded in Digital Performer.
Figure 6-1: The ‘Configure Hardware Driver’ menu item produces the
MOTU 828 settings shown above. This window provides all of the
settings for your MOTU 828 hardware.

Sample rate
Choose either 44.1 or 48 KHz as the overall sample
rate for the MOTU 828 system and Digital
Performer. Newly recorded audio in Digital
Performer will have this sample rate. Imported
audio or soundbites in existing files that do not
match this sample rate will be displayed in the
Soundbites window with a red ‘X’ on its move
handle to indicate that it cannot be played.

Smaller Samples Per Buffer settings reduce latency,
but they also put more demand on your computer’s
processor (as shown in the Performance Monitor
window). For best results, try 256 samples or lower,
which reduces latency enough to be inaudible for
most audio material. If Digital Performer gets
sluggish, try the next higher setting until the
computer feels responsive enough to you. Keep an
eye on the Processor meter in the Performance
monitor when making this adjustment. Be sure to
try playing some audio, too, as the processor meter
can jump up significantly during playback at lower
settings. You can also use Cue Mix Plus no-latency
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monitoring as described in “Monitoring live input”
on page 38 and “Monitor input — CueMix™ Plus”
on page 37.

Figure 6-2: When adjusting the ‘Samples Per Buffer’ to reduce
monitoring latency, watch the ‘processor’ meter in the Performance
Monitor. If you hear distortion, or if the Performance meter is
peaking, try raising the Samples Per Buffer setting.

Optical input and output
To make a MOTU 828 optical input or output
available in Digital Performer, choose the
appropriate format (ADAT optical or TOSLink)
from the optical input and/or output menu. If you
won’t be using the optical connectors, turn them
off.
Auto Monitor
The Auto Monitor option (Figure 6-1 on page 42)
automatically changes the MOTU 828 CueMix™
Plus monitor input when you record-enable a track
in Digital Performer whose output assignment is
Analog 1-2. For example, if you record-enabled a
track called guitar in your Digital Performer
project, its audio output assignment is Analog 1-2,
and its audio input assignment is analog 2, the
MOTU 828 CueMix Plus Monitor Input setting (see
“Monitor input — CueMix™ Plus” on page 37) will
automatically be changed to analog input #2.
The Monitor Input option requires the following
additional settings shown below in Figure 6-3:
1 From the Basics menu, choose MOTU Audio
System options>Input Monitoring Mode.
2 Choose the Direct hardware playthrough option.
3 In the Audio Monitor window, turn on Audio
Patch thru by enabling the headphone button
shown below.

Figure 6-3: To enable the CueMix™ Plus Auto Monitor feature in
AudioDesk or Digital Performer, be sure the ‘Direct hardware playthrough’ option is chosen, and be sure audio patch thru is turned on.

☛

Remember: the Auto Monitor feature only
responds to tracks whose output setting is Analog
1-2 (since the MOTU 828 CueMix Plus feature
sends audio only to the main outputs).
Auto Monitor playthrough is ‘dry’
As you can see in Figure 6-3 above, there are two
ways to monitor live audio input in Digital
Performer: 1) directly through the audio hardware
(the MOTU 828 only) or 2) through Digital
Performer’s virtual mixing environment, which
may include real-time plug-in effects processing on
the live input signal. The Auto Monitor option
discussed in the previous section requires
method 1, and therefore does not allow plug-in
effects processing. You can, however, employ both
types of monitoring at the same time (both ‘dry’
hardware monitoring and ‘wet’ monitoring
through Digital Performer) by choosing the
Monitor record-enabled tracks through effects
option shown in Figure 6-3 above and then
manually choosing a Monitor Input in the MOTU
828 Control Panel (as discussed in “Monitor input
— CueMix™ Plus” on page 37). For further
information about monitoring live input, see
“Monitoring live input” on page 38.
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BE SURE YOU HAVE ENOUGH VOICES
Go to the Basics menu and choose MOTU Audio
System Options>Configure Studio Size. Then check
to make sure you have enough mono and stereo
audio voices for the work you need to do. Consult
the MOTU Audio System chapter in your Digital
Performer manual for further information about
the settings in this dialog.

TRIMMING THE ANALOG INPUTS
The MOTU 828 analog inputs provide trim knobs
on the front panel. Each knob provides up to 40dB
of input gain. To calibrate an audio input:

remain exactly at its original sample location
(unless you move it in Digital Performer, of
course).
Occasionally, you may encounter a situation in
which you observe a slight offset of one sample —
or maybe a few — caused by inherent latencies in
the devices you are using with the MOTU 828.
Usually, these offsets will be consistent, and you
can compensate for them in Digital Performer. To
do so, choose MOTU Audio System Options>Finetune Audio I/O Timing from the Basics menu as
shown in Figure 6-4.

1 Record-enable a track in Digital Performer.
2 Choose the desired MOTU 828 input for the
track.
3 Open the Audio Monitor window.
4 As you feed signal to the input, adjust the input’s
corresponding trim knob on the front panel of the
MOTU 828 until peaks in the level meter are as
high as possible without clipping (hitting zero dB).

24-BIT OPERATION
Your MOTU 828 hardware fully supports Digital
Performer’s 24-bit recording capabilities, including
both analog and digital 24-bit recording. If you
would like to record and play back 24-bit audio
files, go to the Basics menu, choose MOTU Audio
System options>Configure Sample Format, and
choose 24-bit recording as the sample format. This
setting is saved with the Digital Performer project.

FINE-TUNING I/O TIMING
The MOTU 828 system has the ability to be sample
accurate. This means that when you transfer audio
between Digital Performer and an ADAT, for
example, you can record the audio back and forth
as many times as you want between them and it will

Figure 6-4: Fine-tuning the timing of audio playback and recording.

SYNCHRONIZATION
Digital Performer can run under its own transport
control or slave to an external sync source, such as
SMPTE time code or ADAT sync (sample address).
Running DP under its own transport control
If you do not need to synchronize Digital
Performer with time code or another recording
device, such as a tape deck, just leave the Slave to
External Sync command in the Basics menu
unchecked.
However, even though Digital Performer is not
slaving to external sync, you still need to be
concerned with the synchronization of the MOTU
828’s digital audio clock with other devices
connected to it digitally (if any). For example, if
you have a digital mixer connected to the MOTU
828 via an ADAT optical lightpipe cable, you need
to make sure that their audio clocks are phase-
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locked. For details, see “Syncing optical devices”
on page 25 and “Making sync connections” on
page 19. If you don’t have any digital audio devices
connected to the MOTU 828, digital audio phaselock does not apply to you.
Slaving DP and the MOTU 828 to SMPTE time
code
If you need to slave Digital Performer and the
MOTU 828 system to SMPTE time code, choose
Receive Sync from the Basics menu and choose the
MTC (MIDI Time Code) option. Then make sure
that the Slave to External Sync command in the
Basic menu is checked. To ensure that your audio
tracks don’t drift out of sync with your MIDI tracks
— or time code, use a hardware synchronizer like
the MIDI Timepiece AV or Digital Timepiece to
slave the MOTU 828 hardware to the SMPTE (or
MIDI Time) Code as well. An ADAT-compatible
digital audio synchronizer like the MOTU MIDI
Timepiece AV is required for drift-free SMPTE/
MIDI time code sync. Make sure the MOTU 828
Clock Source setting (Figure 6-1 on page 42) is set
to ADAT 9-pin and you’ll need the synchronization
setup shown in Figure 3-12 on page 24.

☛

If you have an ADAT or ADAT synccompatible device, don’t use SMPTE time code.
Instead, use sample-accurate sync as described in
the next section.
Sample-accurate sync to ADAT
Together, Digital Performer and the MOTU 828
system provide you with sample-accurate transfers
with ADATs and any other devices that support
standard ADAT sample address (ADAT Sync).

A sample-accurate transfer is one in which the
original location of the audio is preserved in the
transfer, down to the sample.

Performer’s Receive Sync dialog (Basics menu), and
make sure that the Slave to External Sync command
is checked in the Basic menu, too.
To control the transports of everything together
from Digital Performer, see the next section.

MIDI MACHINE CONTROL (MMC)
If you have ADATs and a MMC-compatible ADAT
synchronizer like the MIDI Timepiece AV or
Digital Timepiece, you can control everything
from your computer screen with Digital
Performer’s transport controls and cueing features
(like Markers, the playback wiper, etc.)
See the MIDI Machine Control chapter in your
MIDI Timepiece AV or Digital Timepiece manual
for details on how to set this up.

REDUCING DELAY WHEN MONITORING
LIVE INPUTS
If you have live audio inputs connected to the
MOTU 828, such as MIDI synthesizers, samplers,
microphones or other live instruments, you might
hear a slight delay when their audio is being
patched through your MOTU 828 hardware and
Digital Performer. There are several ways to reduce
— and eliminate — this audible monitoring delay.
For details, see “Monitoring live input” on page 38.

USING A FOOT SWITCH
Use a foot switch connected to the MOTU 828 to
trigger recording punch-in and punch-out, or any
other feature in Digital Performer that is assigned
to a computer keystroke. By default, the foot switch
triggers the 3 key on the computer keypad (which
toggles Digital Performer’s record button.) To
trigger a different set of keystrokes with the foot
switch, visit the MOTU 828 Control Panel. (See
“Enable Pedal” on page 37.)

For details on how to set up sample-accurate sync,
see “Sample-accurate sync” on page 21. Be sure to
choose the Sample Accurate Sync option in Digital
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EXCHANGING PROJECTS WITH AUDIODESK
Digital Performer (Version 2.6 or later) can
exchange files with AudioDesk 1.0. For example,
you can transfer a file from Digital Performer to
AudioDesk, and back again. Just use Save As in
Digital Performer’s File menu and choose the
AudioDesk file format. To open AudioDesk files in
Digital Performer, just use the Open command.
(No conversion is required beforehand in
AudioDesk.)

If you have an earlier version of Digital Performer
(2.5 or earlier), you can open your Digital
Performer files in AudioDesk (with the Open
command in the File menu), but Digital Performer
2.5 or earlier cannot open AudioDesk files.

SOUND MANAGER AND DIGITAL
PERFORMER
Digital Performer includes a MOTU Audio System
plug-in called AudioTap that allows you to route
any Sound Manager audio into Digital Performer’s
mixing environment. From there, you can route it
to your MOTU 828 interface via any of Digital
Performer’s extensive audio routing features. For
details, consult your Digital Performer documentation.
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CHAPTER 7

The MOTU 828 and AudioDesk

OVERVIEW

SETTING UP YOUR SYSTEM

This chapter provides a brief overview of
AudioDesk’s basic I/O and synchronization
operation with the MOTU 828 hardware. For
complete information about all of AudioDesk’s
powerful workstation features, see the AudioDesk
manual included with your MOTU 828 system.

As described in chapter 4, “Installing the MOTU
828 Macintosh Software” (page 29), the MOTU
828/AudioDesk software installer will properly
install everything for you.

Setting up your system. . . . . . . . . . . . . . . . . . . . . .47
The MOTU 828 settings. . . . . . . . . . . . . . . . . . . . .47
Be sure you have enough voices . . . . . . . . . . . . . .50
Trimming the analog inputs . . . . . . . . . . . . . . . . .50
24-bit operation. . . . . . . . . . . . . . . . . . . . . . . . . . . .50
Fine-tuning I/O timing . . . . . . . . . . . . . . . . . . . . .50
Synchronization . . . . . . . . . . . . . . . . . . . . . . . . . . .50
MIDI Machine Control (MMC) . . . . . . . . . . . . . .51
Reducing delay when monitoring live inputs . .51
Using a foot switch . . . . . . . . . . . . . . . . . . . . . . . . .51
Exchanging projects with Digital performer. . .51
AudioDesk and MIDI sequencing . . . . . . . . . . . .52

If you will be using AudioDesk’s MIDI Machine
Control (MMC) or MIDI Time Code sync features,
FreeMIDI must be installed. (You can do this from
the MOTU 828 installer CD.)
If you are using a MIDI Timepiece AV or Digital
Timepiece for synchronization, be sure they are
present in your FreeMIDI setup.

THE MOTU 828 SETTINGS
The MOTU 828 settings can be accessed by
choosing MOTU Audio System options>Configure
Hardware Driver from the Basics menu. If you don’t
see the MOTU 828 settings as shown below in
Figure 7-1, choose MOTU 828 from the menu at
the top of the Configure Hardware dialog. For
complete details about the important settings in
this window, see chapter 5, “MOTU 828 Control
Panel” (page 33).
The following sections provide a brief explanation
of each MOTU 828 setting for use with AudioDesk.
For a more complete overview, see chapter 5,
“MOTU 828 Control Panel” (page 33).
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If you do not have any digital audio connections to
your MOTU 828 (you are using the analog inputs
and outputs only), and you will not be slaving
AudioDesk to external SMPTE time code, choose
Internal.
If you are slaving the MOTU 828 to the ADAT sync
Input connector, choose ADAT 9-pin.
If you have digital audio devices connected to the
MOTU 828, or if you are not sure about the clock
source of your setup, be sure to read “Making sync
connections” on page 19 and “Clock Source” on
page 34.

Figure 7-1: The ‘Configure Hardware Driver’ menu item produces the
MOTU 828 settings shown above. This window provides all of the
settings for your MOTU 828 hardware.

Sample rate
Choose either 44.1 or 48 KHz as the overall sample
rate for the MOTU 828 and AudioDesk. Newly
recorded audio in AudioDesk will have this sample
rate. Imported audio or soundbites in existing files
that do not match this sample rate will be displayed
in the Soundbites window with a red ‘X’ on its
move handle to indicate that it cannot be played.
Clock Source
This setting is very important because it
determines which audio clock the MOTU 828
system will follow.

Samples Per Buffer
The Samples Per Buffer setting can be used to
reduce the delay — or monitoring latency — that
you hear when live audio is patched through your
MOTU 828 hardware and AudioDesk. For
example, you might have MIDI instruments,
samplers, microphones, and so on connected to
the analog inputs of the MOTU 828. If so, you will
often be mixing their live input with audio material
recorded in AudioDesk.
Smaller Samples Per Buffer settings reduce latency,
but they also put more demand on your computer’s
processor (as shown in the Performance Monitor
window). For best results, try 256 samples or lower,
which reduces latency enough to be inaudible for
most audio material. If AudioDesk gets sluggish,
try the next higher setting until the computer feels
responsive enough to you. Keep an eye on the
Processor meter in the Performance monitor when
making this adjustment. Be sure to try playing
some audio, too, as the processor meter can jump
up significantly during playback at lower settings.
You can also use Cue Mix Plus no-latency
monitoring as described in “Monitoring live input”
on page 38 and “Monitor input — CueMix™ Plus”
on page 37.

48
T HE M O T U 8 2 8 AND AUDI O DE SK

!828 Manual/Mac Page 49 Thursday, March 1, 2001 9:46 AM

Figure 7-2: When adjusting the ‘Samples Per Buffer’ to reduce
monitoring latency, watch the ‘processor’ meter in the Performance
Monitor. If you hear distortion, or if the Performance meter is
peaking, try raising the Samples Per Buffer setting.

Optical input and output
To make a MOTU 828 optical input or output
available in AudioDesk, choose the appropriate
format (ADAT optical or TOSLink) from the optical
input and/or output menu. If you won’t be using
the optical connectors, turn them off.
Auto Monitor
The Auto Monitor option (Figure 7-1 on page 48)
automatically changes the MOTU 828 CueMix™
Plus monitor input when you record-enable a track
in AudioDesk. For example, if you record-enabled
a track called guitar in your AudioDesk project, its
audio output assignment is Analog 1-2, and its
audio input assignment is analog 2, the MOTU 828
CueMix Plus Monitor Input setting (see “Monitor
input — CueMix™ Plus” on page 37) will
automatically be changed to analog input #2.
The Monitor Input option requires the following
additional settings shown below in Figure 7-3:
1 From the Basics menu, choose MOTU Audio
System options>Input Monitoring Mode.
2 Choose the Direct hardware playthrough option.
3 In the Audio Monitor window, turn on Audio
Patch thru by enabling the headphone button
shown below.

Figure 7-3: To enable the CueMix™ Plus Auto Monitor feature in
AudioDesk or AudioDesk, be sure the ‘Direct hardware playthrough’
option is chosen, and be sure audio patch thru is turned on.

☛

Remember: the Auto Monitor feature only
responds to tracks whose output setting is Analog
1-2 (since the MOTU 828 CueMix Plus feature
sends audio only to the main outputs).
Auto Monitor playthrough is ‘dry’
As you can see in Figure 7-3 above, there are two
ways to monitor live audio input in AudioDesk: 1)
directly through the audio hardware (the MOTU
828 only) or 2) through AudioDesk’s virtual
mixing environment, which may include real-time
plug-in effects processing on the live input signal.
The Auto Monitor option discussed in the previous
section requires method 1, and therefore does not
allow plug-in effects processing. You can, however,
employ both types of monitoring at the same time
(both ‘dry’ hardware monitoring and ‘wet’
monitoring through AudioDesk) by choosing the
Monitor record-enabled tracks through effects
option shown in Figure 7-3 above and then
manually choosing a Monitor Input in the MOTU
828 Control Panel (as discussed in “Monitor input
— CueMix™ Plus” on page 37). For further
information about monitoring live input, see
“Monitoring live input” on page 38.
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BE SURE YOU HAVE ENOUGH VOICES
Go to the Basics menu and choose MOTU Audio
System Options>Configure Studio Size. Then check
to make sure you have enough mono and stereo
audio voices for the work you need to do. Consult
the MOTU Audio System chapter in your
AudioDesk manual for further information about
the settings in this dialog.

Occasionally, you may encounter a situation in
which you observe a slight offset of one sample —
or maybe a few — caused by inherent latencies in
the devices you are using with the MOTU 828.
Usually, these offsets will be consistent, and you
can compensate for them in AudioDesk. To do so,
choose MOTU Audio System Options>Fine-tune
Audio I/O Timing from the Basics menu as shown
in Figure 7-4.

TRIMMING THE ANALOG INPUTS
The MOTU 828 analog inputs provide trim knobs
on the front panel. Each knob provides 40dB of
input gain. To calibrate an audio input:
1 Record-enable a track in AudioDesk.
2 Choose the desired MOTU 828 input for the
track.
3 Open the Audio Monitor window.
4 As you feed signal to the input, adjust the input’s
corresponding trim knob on the front panel of the
MOTU 828 until peaks in the level meter are as
high as possible without clipping (hitting zero dB).

24-BIT OPERATION
Your MOTU 828 hardware fully supports
AudioDesk’s 24-bit recording capabilities,
including both analog and digital 24-bit recording.
If you would like to record and play back 24-bit
audio files, go to the Basics menu, choose MOTU
Audio System options>Configure Sample Format,
and choose 24-bit recording as the sample format.
This setting is saved with the AudioDesk project.

FINE-TUNING I/O TIMING
The MOTU 828 system has the ability to be sample
accurate. This means that when you transfer audio
between AudioDesk and an ADAT, for example,
you can record the audio back and forth as many
times as you want between them and it will remain
exactly at its original sample location (unless you
move it in AudioDesk, of course).

Figure 7-4: Fine-tuning the timing of audio playback and recording.

SYNCHRONIZATION
AudioDesk can run under its own transport
control or slave to an external sync source, such as
SMPTE time code or ADAT sync (sample address).
Running AudioDesk under its own transport
control
If you do not need to synchronize AudioDesk with
time code or another recording device, such as a
tape deck, just leave the Slave to External Sync
command in the Basics menu unchecked.
However, even though AudioDesk is not slaving to
external sync, you still need to be concerned with
the synchronization of the MOTU 828’s digital
audio clock with other devices connected to it
digitally (if any). For example, if you have a digital
mixer connected to the MOTU 828 via an ADAT
optical lightpipe cable, you need to make sure that
their audio clocks are phase-locked. For details, see
“Syncing optical devices” on page 25 and “Making
sync connections” on page 19. If you don’t have any
digital audio devices connected to the MOTU 828,
digital audio phase-lock does not apply to you.
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Slaving AudioDesk and the MOTU 828 to
SMPTE time code
If you need to slave AudioDesk and the MOTU 828
system to SMPTE time code, choose Receive Sync
from the Basics menu and choose the MTC (MIDI
Time Code) option. Then make sure that the Slave
to External Sync command in the Basic menu is
checked. To ensure that your audio tracks don’t
drift out of sync with the SMPTE time code, use a
hardware synchronizer like the MIDI Timepiece
AV or Digital Timepiece to slave the MOTU 828
hardware to the SMPTE (or MIDI Time) Code as
well. An ADAT sync-compatible digital audio
synchronizer is required for drift-free
SMPTE/MIDI time code sync. Make sure the
MOTU 828 Clock Source setting (Figure 7-1 on
page 48) is set to ADAT 9-pin and you’ll need the
synchronization setup shown in Figure 3-12 on
page 24.

☛

If you have an ADAT or ADAT
sync-compatible device, don’t use SMPTE time
code. Instead, use sample-accurate sync as
described in the next section.
Sample-accurate sync to ADAT or Control Track
Together, AudioDesk and the MOTU 828 system
provide you with sample-accurate transfers with
ADATs and any other devices that support
standard ADAT sample address (ADAT Sync).

A sample-accurate transfer is one in which the
original location of the audio is preserved in the
transfer, down to the sample.
For details on how to set up sample-accurate sync,
see “Sample-accurate sync” on page 21. Be sure to
choose the Sample Accurate Sync option in
AudioDesk’s Receive Sync dialog (Basics menu),
and make sure that the Slave to External Sync
command is checked in the Basic menu, too.

MIDI MACHINE CONTROL (MMC)
If you have ADATs and a MMC-compatible ADAT
synchronizer like the MIDI Timepiece AV or
Digital Timepiece, you can control everything
from your computer screen with AudioDesk’s
transport controls and cueing features (like
Markers, the playback wiper, etc.)
See the MIDI Machine Control chapter in your
MIDI Timepiece AV or Digital Timepiece manual
for details on how to set this up.

REDUCING DELAY WHEN MONITORING
LIVE INPUTS
If you have live audio inputs connected to the
MOTU 828, such as MIDI synthesizers, samplers,
microphones or other live instruments, you might
hear a slight delay when their audio is being
patched through your MOTU 828 hardware and
AudioDesk. There are several ways to reduce —
and eliminate — this audible monitoring delay. For
details, see “Monitoring live input” on page 38.

USING A FOOT SWITCH
Use a foot switch connected to the MOTU 828 to
trigger recording punch-in and punch-out, or any
other feature in AudioDesk that is assigned to a
computer keystroke. By default, the foot switch
triggers the 3 key on the computer keypad (which
toggles AudioDesk’s record button.) To trigger a
different set of keystrokes with the foot switch, visit
the MOTU 828 Control Panel. (See “Enable Pedal”
on page 37.)

EXCHANGING PROJECTS WITH DIGITAL
PERFORMER
AudioDesk 1.0 can exchange files with Digital
Performer (Version 2.6 or later). For example, you
can transfer a file from Digital Performer to
AudioDesk, and back again. Just use Save As in
Digital Performer’s File menu and choose the
AudioDesk file format. To open AudioDesk files in

To control the transports of everything together
from AudioDesk, see the next section.
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Digital Performer, just use the Open command.
(No conversion is required beforehand in
AudioDesk.)
If you have an earlier version of Digital Performer
(2.5 or earlier), you can open your Digital
Performer files in AudioDesk (with the Open
command in the File menu), but Digital Performer
2.5 or earlier cannot open AudioDesk files.

AUDIODESK AND MIDI SEQUENCING
AudioDesk can play audio as a background
application, allowing you to run a sequencer at the
same time in the foreground. However, there is no
way to continuously synchronize — or resolve — a
sequencer with AudioDesk, so the two programs
will eventually drift out of sync, even if you manage
to start them at the same time. If you’d like to do
integrated MIDI sequencing, your best bet is
Digital Performer, which offers pretty much all of
the same features as AudioDesk, along with
powerful, state-of-the-art MIDI sequencing. Talk
to your authorized MOTU dealer for details about
upgrading from AudioDesk to Digital Performer.
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CHAPTER 8

The MOTU 828 and Other Audio
Software

OVERVIEW

ASIO DRIVER SUPPORT IS REQUIRED

The MOTU 828 includes an ASIO driver that
provides multi-channel I/O with any ASIOcompatible audio software.

ASIO is an acronym for Audio Streaming Input and
Output. The ASIO MOTU 828 driver allows the
MOTU 828 to provide multi-channel audio input
and output for any audio application that supports
ASIO drivers.

ASIO driver support is required. . . . . . . . . . . . . .53
Check your setup with AudioDesk first . . . . . . .54
Check the MOTU 828 ASIO driver . . . . . . . . . . .54
Check the MOTU 828 Control Panel. . . . . . . . . .54
Enable the MOTU 828 ASIO driver. . . . . . . . . . .54
Number of audio channels . . . . . . . . . . . . . . . . . .55
Working with MOTU 828 inputs and outputs .55
Trimming the analog inputs . . . . . . . . . . . . . . . . .56
Using a foot switch . . . . . . . . . . . . . . . . . . . . . . . . .56
Changing MOTU 828 settings . . . . . . . . . . . . . . .56
Reducing delay when monitoring live inputs . .56
Audio clock source . . . . . . . . . . . . . . . . . . . . . . . . .56
Synchronization . . . . . . . . . . . . . . . . . . . . . . . . . . .56
MIDI Machine Control (MMC) . . . . . . . . . . . . . .58
24-bit operation. . . . . . . . . . . . . . . . . . . . . . . . . . . .58

☛

For multi-channel operation with third-party
audio software, the MOTU 828 requires ASIO
compatibility. If your host audio program does not
support ASIO, contact the developer.
Sample-accurate sync
The MOTU 828 ASIO driver supports sampleaccurate sync (via the MOTU 828’s ADAT sync
feature) for applications that support it.
Attention: Digital Performer users
Digital Performer supports ASIO, but it also
accesses the MOTU 828 directly through the
MOTU Audio System, so it is not necessary to use
the ASIO driver with Digital Performer.
Attention: Cubase VST users
Cubase VST Version 5 is used for the examples in
this chapter. However, there is no significant
difference between the Version 5 examples shown
and what you see in Version 4. The basic
procedures are the same.
Attention: Other software users
Cubase VST is used for the examples in this
chapter. However, the basic procedures are the
same and can be easily applied to any ASIOcompatible software. Just follow the general
descriptions at the beginning of each main section
in this chapter. Consult your software
documentation for details about each topic, if
necessary.
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CHECK YOUR SETUP WITH AUDIODESK
FIRST

CHECK THE MOTU 828 CONTROL PANEL
Before you run your audio software, launch the
MOTU 828 Control Panel to configure your
MOTU 828 hardware. The MOTU 828 Control
Panel lets you choose the audio clock source, and it
lets you enable the optical input and output, if
needed. For details, see chapter 5, “MOTU 828
Control Panel” (page 33).

Before you run your third-party audio software
with the MOTU 828, launch AudioDesk and play
back the demo project to make sure that the
MOTU 828 hardware and software drivers are set
up properly. The AudioDesk demo project is
located on the MOTU 828 Installer CD-ROM.
Drag it to your hard drive before opening it in
AudioDesk, as your CD-ROM drive probably will
be too slow to play the audio.

CHECK THE MOTU 828 ASIO DRIVER
For Cubase and most other ASIO-compatible
programs, the ASIO MOTU 828 driver should be
placed in the ASIO folder of the ASIO-compliant
software that you are running as the software “front
end” for the MOTU 828. To check this quickly, use
your computers search utility (Sherlock or other
utility) and search using the word ASIO. Drag the
ASIO MOTU 828 driver to the appropriate folder,
if necessary. If you can’t find it, run the MOTU 828
installer again and do a Custom Install.

Figure 8-2: The MOTU 828 Control Panel gives you access to all of the
settings in the MOTU 828 hardware, including the clock source,
optical I/O enable/disable and CueMix™ Plus monitor input(s).

ENABLE THE MOTU 828 ASIO DRIVER
Once you’ve made the preparations described so
far in this chapter, you’re ready to run your audio
software and enable the MOTU 828 driver. Check
the audio system or audio hardware configuration
window in your software. There will be a menu
there that lets you choose among various ASIO
drivers that may be in your system. Choose the
MOTU 828 from this menu.
Figure 8-1: If your ASIO-compatible audio software has a folder
called ‘ASIO Drivers’ at the time that you install the MOTU 828
software, The MOTU 828 installer puts the ‘ASIO MOTU 828’ driver in
the ASIO Drivers folder.

Enabling the MOTU 828 ASIO driver in Cubase
To activate the MOTU 828 ASIO driver in Cubase:
1 Choose System from the Audio menu.
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2 Choose MOTU 828 from the ASIO device
menu.

In Cubase, set the number of channels in the
System dialog (as shown above in Figure 8-3).

3 Make the other settings in the dialog as need for
your system and synchronization scenario.

WORKING WITH MOTU 828 INPUTS AND
OUTPUTS
Once you’ve enabled the MOTU 828 ASIO driver in
your host audio software, MOTU 828 audio inputs
and outputs will appear in your software’s
input/output menus, and you can set them up and
use them as any standard audio input and output.
If you don’t see the optical inputs and/or outputs,
check the MOTU 828 Control Panel to make sure
they are turned on and set to the format you
require. If you don’t plan to use the optical input or
output, turn it off to conserve computer
bandwidth.

Figure 8-3: Activating the MOTU 828 driver in Cubase. The Audio
Clock Source setting shown here is for the MOTU 828. You can also
choose the clock source in the MOTU 828 Control Panel or Control
Strip module.

NUMBER OF AUDIO CHANNELS
Be sure to configure your audio software so that it
has enough audio channels (or voices) to cover the
18 channels of input and output provided by the
MOTU 828:
■

8 channels for analog I/O

■

2 channels for RCA S/PDIF

MOTU 828 inputs/outputs in Cubase
Once you’ve chosen the MOTU 828 driver in the
Audio System dialog, choose Audio Inputs from the
Audio menu to see the MOTU 828 inputs. To
activate them, click the Active light next to each
input. Once you’ve activated the MOTU 828
inputs, you can then assign them to Cubase audio
channels in the Monitor window in the usual
fashion (by command-clicking on the input button
at the top of each channel strip). MOTU 828
outputs appear in the Master window as output
assignments for the master fader and busses.

■ Zero, 2 or 8 channels for optical, depending on
whether you have optical turned off, or set to
S/PDIF or ADAT optical

For example, if you are using analog only, you only
need 8 channels. If you are using analog and RCA
S/PDIF, you need 10 channels.
As another example, if you are using analog, RCA
S/PDIF and ADAT optical, you need 18 channels
(the maximum number of simultaneous channels
provided by the MOTU 828).
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program is currently using it). Therefore, you may
need to quit your audio software to change the
desired MOTU 828 setting.

REDUCING DELAY WHEN MONITORING
LIVE INPUTS

Figure 8-4: Use the output buttons at the bottom of each channel
strip to assign MOTU 828 outputs to busses. You can then assign
channels in the Monitor window to each bus as desired.

TRIMMING THE ANALOG INPUTS
The MOTU 828 analog inputs provide trim knobs
on the front panel. Each knob provides 40dB of
input gain. Use the level meters in your audio
software to calibrate these inputs before recording.
As you feed signal to the MOTU 828 analog input,
adjust the input’s corresponding trim knob on the
front panel of the MOTU 828 until peaks in your
software’s level meter are as high as possible
without clipping (hitting zero dB).

USING A FOOT SWITCH
Use a foot switch connected to the MOTU 828 to
trigger recording punch-in and punch-out, or any
other feature in your host audio software that is
assigned to a computer keystroke. By default, the
foot switch triggers the 3 key on the computer
keypad. To trigger a different set of keystrokes with
the foot switch, visit the MOTU 828 Control Panel.
(See “Enable Pedal” on page 37.)

CHANGING MOTU 828 SETTINGS
You can change the MOTU 828 settings at any time
by accessing either the MOTU 828 Control Panel
or the Control Strip module. (See “Accessing the
MOTU 828 settings” on page 33.) However, some
settings are grayed out and cannot be changed
when the MOTU 828 ASIO driver is active (when a

If you have live audio inputs connected to the
MOTU 828, such as MIDI synthesizers, samplers,
microphones or other live instruments, you might
hear a slight delay when their audio is being
monitored through your MOTU 828 hardware and
your host audio program. (In Cubase, this delay is
displayed under Latency in the Audio System
dialog shown in Figure 8-3.) There are several ways
to reduce — and eliminate — this audible
monitoring delay. For details, see “Monitoring live
input” on page 38.

AUDIO CLOCK SOURCE
If you have devices connected to the MOTU 828
digital inputs (optical or RCA S/PDIF), or if you
need to synchronize MOTU 828 digital audio and
your host audio software to an external sync
source, be sure the MOTU 828 clock source is set
properly. For complete information, see “Making
sync connections” on page 19 and “Clock Source”
on page 34.

SYNCHRONIZATION
If your audio software has the ability to slave to
SMPTE time code or perform sample-accurate
digital audio transfers with Alesis ADATs, then it
can take advantage of the synchronization features
in the MOTU 828.
As you read through the following sections to
decide what form of synchronization you might
need with other devices in your studio, be sure to
consult “Making sync connections” on page 19 for
the proper hardware connections. Use the
synchronization diagrams to be clear about how
you will be synchronizing your audio software and
the MOTU 828 to the other components of your
system.

56
T H E M O T U 8 2 8 AND O T H E R AUDI O SO F T W AR E

!828 Manual/Mac Page 57 Thursday, March 1, 2001 9:46 AM

Synchronizing digital audio connections
If you have devices connected to the MOTU 828
digital inputs (optical or RCA S/PDIF), you need to
be concerned with the synchronization of the
MOTU 828’s digital audio clock with other devices
connected to it digitally (if any). For example, if
you have a digital mixer connected to the
MOTU 828 via an ADAT optical lightpipe cable,
you need to make sure that their audio clocks are
phase-locked. For details, see “Syncing optical
devices” on page 25 and “Making sync
connections” on page 19. If you don’t have any
digital audio devices connected to the MOTU 828,
digital audio phase-lock does not apply to you.
Slaving to SMPTE time code
If you need to slave your audio software and the
MOTU 828 system to SMPTE time code, follow the
instructions in your software’s manual for slaving it
to MIDI Time Code (MTC). To ensure that your
audio tracks don’t drift out of sync with your MIDI
tracks or the time code, use a hardware
synchronizer like the MOTU MIDI Timepiece AV
or Digital Timepiece to slave the MOTU 828
hardware to the SMPTE (or MIDI Time) Code as
well. A digital audio synchronizer is required for
drift-free SMPTE/MIDI time code sync. Make sure
the Clock Source setting in the MOTU 828 Control
Panel is set to ADAT 9-pin. For examples of how to
set this up, see “Sync to SMPTE, word clock, video”
on page 24.
Sample-accurate sync to ADAT
If your audio software supports sample-accurate
synchronization, the MOTU 828 provides sampleaccurate digital transfers between the computer
and ADATs, or any other device that supports
standard ADAT sample address (ADAT Sync).

For details on how to connect your hardware for
sample-accurate sync, see “Sample-accurate sync”
on page 21. For software setup, consult your audio
software documentation.
Sample-accurate sync with Cubase
For sample-accurate sync in Cubase, set up Cubase
as follows:
1 In Cubase’s MIDI System Setup window, set
OMS compatibility to No OMS. VST does not
appear to be able to achieve sample-accurate sync
when running under OMS.
2 In Cubase’s Audio System Setup window (Audio
menu), choose an Audio Clock Source setting of
ADAT 9-pin.
3 In Cubase’s Synchronization window, set the
Sync Source Time Base to ASIO 2.0 as shown
below:

Figure 8-5: Setting up sample-accurate sync via ASIO 2.

4 Enable SYNC in the Controls window.

Figure 8-6: Enabling the SYNC button.

A sample-accurate digital transfer is one in which
the original location of the audio is preserved in the
transfer, down to the sample.

5 Begin playback from the sample-accurate sync
source (ADAT, etc.) Transport control is handled
by the sample-accurate sync source.
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The ASIO 2.0 MMC setting in Cubase
The Timecode Base menu shown above in
Figure 8-5 includes a setting called ASIO 2.0 MMC,
which provides sample-accurate transport control
of the MOTU MIDI Timepiece AV (or other
MMC-compatible synchronizer) from the
transport buttons in Cubase itself.

MIDI MACHINE CONTROL (MMC)
If your audio software supports MIDI Machine
Control (MMC), and you have ADATs and a
MMC-compatible ADAT synchronizer like the
MIDI Timepiece AV, you can control everything

from the transport controls and cueing features in
your audio software (like the playback wiper, etc.)
See “Sample-accurate sync to ADAT” on page 57
for details on how to set this up.

24-BIT OPERATION
Your MOTU 828 hardware fully supports 24-bit
recording in any audio software that supports it.
Simply enable 24-bit operation as instructed by the
software. The MOTU 828 system always supplies
the software with a 24-bit data stream, and when
you enable 24-bit operation, it simply uses all
24-bits supplied by the MOTU 828 hardware.
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CHAPTER 9

Sound Manager

OVERVIEW
Sound Manager is a standard Mac OS System
Extension that provides stereo sound capabilities
on your Power Macintosh. The MOTU 828 system
extensions support Sound Manager. This support
allows your Power Macintosh to use any pair of
inputs and outputs (analog or digital) on the
MOTU 828, instead of the Mac’s built-in audio
inputs/outputs (if any).
Using 3rd party audio software . . . . . . . . . . . . . .59
Sound Manager is stereo only. . . . . . . . . . . . . . . .59
Sound Manager supports 44.1kHz only . . . . . . .59

SOUND MANAGER SUPPORTS 44.1KHZ
ONLY
The MOTU 828 can run at either 44.1 kHz or
48 kHz. However, Sound Manager only supports
44.1 kHz (in OS8 and OS9 — future versions may
support 48 kHz). Therefore, you must set the
MOTU 828 to run at 44.1 kHz to use it with Sound
Manager.

ENABLING SOUND MANAGER I/O
Use the MOTU 828 Control Panel or Control Strip
to enable Sound Manager I/O and choose the
inputs and outputs that you wish to use for Sound
Manager I/O.

Enabling Sound Manager I/O. . . . . . . . . . . . . . . .59
The Sound control panel . . . . . . . . . . . . . . . . . . . .59
Changing the inputs or outputs . . . . . . . . . . . . . .60
Monitoring live inputs . . . . . . . . . . . . . . . . . . . . . .60
AudioTap™ and Digital Performer . . . . . . . . . . .60

USING 3RD PARTY AUDIO SOFTWARE
Just about every application for Macintosh that
supports audio also supports Sound Manager.
Once you’ve installed the MOTU 828 software, you
can use any pair of MOTU 828 inputs and outputs
(analog or digital) to record and play back audio
from any Sound Manager compatible program.

SOUND MANAGER IS STEREO ONLY
Sound Manager currently only supports stereo
input and output. Therefore, Sound Manager
compatible programs can only record two channels
at a time with your MOTU 828 hardware. Similarly,
they can play back audio through one stereo output
pair on the MOTU 828, although most multi-track
audio applications can internally mix more than
two tracks to stereo. Consult your software’s
documentation for details.

THE SOUND CONTROL PANEL
Set up the Sound control panel for the MOTU 828
as follows:
1 Open the Sound Control Panel.
2 Choose Alert Sounds from the menu.
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That’s it. You can now run any Sound Manager
compatible audio software, and play back audio
through the MOTU 828 outputs you’ve chosen in
the MOTU 828 Control Panel.

CHANGING THE INPUTS OR OUTPUTS

Figure 9-1: Lower the alert sound volume to avoid getting blasted by
it through your MOTU 828 hardware.

3 Lower the Alert volume. This prevents the
Macintosh alert sound from blurting out of the
MOTU 828.
4 Choose Input from the menu and click MOTU
828.

Change the MOTU 828 inputs or outputs being
used by Sound Manager in the MOTU 828 Control
Panel or Control Strip module.

MONITORING LIVE INPUTS
If you would like to listen to live inputs as you are
recording them into your Sound Manager
application, you need to use the PCI-324’s
CueMix™ Plus feature. For details, see “Monitor
input — CueMix™ Plus” on page 37.

AUDIOTAP™ AND DIGITAL PERFORMER

Figure 9-2: Choosing the MOTU 828 for Sound Manager input. This
allows any Sound Manager compatible software to receive audio
from a MOTU 828 input (that you’ll choose later in this procedure).

Digital Performer includes a MOTU Audio System
plug-in called AudioTap that allows you to route
any Sound Manager audio into Digital Performer’s
mixing environment. From there, you can route it
to your MOTU 828 interface via any of Digital
Performer’s extensive audio routing features. For
details, consult your Digital Performer documentation.

5 Choose the desired MOTU 828 input source
from the menu provided (as shown above in
Figure 9-2).
6 Choose Output from the menu and click MOTU
828.
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CHAPTER 10

Troubleshooting

Using Pro Tools, Sound Manager and -50 error
When using Sound Manager, Pro Tools software
will only allow audio input via the Macintosh's
Built-in hardware. Therefore, you cannot use the
MOTU 828 as the input device to Pro Tools
software. If the MOTU 828 driver is selected as the
input device in the Sound Control Panel, Pro Tools
will return a -50 error and not launch. You can,
however, select Built-in as the input device and the
MOTU 828 as the output device in the Sound
Control Panel. After doing so, you can run Pro
Tools and monitor your output through the MOTU
828.
Sample accurate sync in AudioDesk and Digital
Performer
When you first use sample accurate sync, be sure to
go to the Receive Sync dialog in Digital Performer
or AudioDesk and switch from “MTC” to “Sampleaccurate.”
Apple CD Player will not play through audio
interface
The Apple CD Player in OS 8.6 or earlier is
programmed to only output to the Built-in Sound
Manager hardware. The Apple CD Player in OS 9
and later is capable of playing audio to any Sound
Manager compatible audio hardware. There are
also several 3rd party CD audio applications
available that are capable of playing audio to any
Sound Manager compatible audio hardware.
Cubase - MOTU 828 inputs and outputs are not
visible in Cubase
You probably need to enable them in Cubase.
Monitoring MOTU 828 input via Sound Manager
With the MOTU 828 and Sound Manager, you
monitor input via CueMix™ Plus. For details, see
“Monitor input — CueMix™ Plus” on page 37.

Can’t authenticate AudioDesk
When installing software off the CD-ROM, the OK
button does not become active until you have
entered in your name and a valid keycode. Your
name must contain at least 3 characters, and you
must enter the keycode exactly as it appears in your
AudioDesk manual (on the inside of the back
cover).
MOTU 828 Control Panel or Control Strip module
settings are grayed out for no apparent reason
Some settings cannot be accessed while the MOTU
828 is active. Quit all audio software that uses the
MOTU 828 (including any Sound Manager
applications, if any), and then the MOTU 828
settings should no longer be grayed out.
ADAT-compatible tape decks - converting 48kHz
tracks to 44.1kHz
If the audio on your ADAT tape was recorded at
48kHz, then you must transfer that audio into your
host software at 48kHz. If you plan to digitally mix
this data and burn an audio CD, you must convert
your audio to 44.1kHz with your host software.
Once you sample rate convert your audio to
44.1kHz, you will have to set the sample rate in the
console back to 44100 so you can play the file. You
always want your digital clocks and sample rates to
match when dealing with any kind of digital audio
transfer or synchronizing.
ADAT-compatible tape decks - device order in
MIDI Machine Control window
When powered on, most modular digital multi
tracks ‘wake up’ configured to record from their
analog inputs by default. You won't be able to
record from the MOTU 828 to a MDM until it is
switched to digital input. Tip: configure this in
ClockWorks or AudioDesk if you want your decks
to come up in the right mode when powered on.
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The order of devices in the DTP panel of the MIDI
Machine Control window is not controlled by the
order of connections to the MOTU 828. This can
be confusing unless you make them match when
connecting the system.
No input on an ADAT tape deck
If you are having trouble recording on your ADAT
tape deck from the MOTU 828, check the Digital
input setting. After power cycling, tape decks often
come up configured to record from their analog
inputs. You won't be able to record from the MOTU
828 to a tape deck until it is switched to digital
input. Tip: configure this in ClockWorks or
AudioDesk if you want your decks to come up in
the right mode when power cycled.
ADATs and the DTP - lock up time allowances
ADATs can take a while to sync to the DTP. For
example, when recording from the MOTU 828 to
the ADATs, they may appear to chase and lock, but
the record button continues to flash. Recorded data
on the tape won’t be sample accurate until the
record light stops flashing. Solution: add more preroll time.
Alesis blackface (classic) ADAT optical sync
If you are using a Classic (black-faced) ADAT as a
sync master in your MOTU 828 setup, and you
want to record sample accurately into it, you must
configure it to use its internal clock, instead of
slaving to the optical input. To do this, hold down
the SET LOCATE button and press the DIGITAL
IN button. This will toggle the ADAT between
external sync (shown as “diG”) and internal sync
(“int”). Note that the ADAT will return to the “diG”
setting each time it is powered off.
Alesis ADAT track offset
If you find that sample accurate transfers from an
ADAT are displaced by a small amount, try to reset
the ADAT to its factory default state. This is
accomplished by powering on the ADAT while
holding down the RECORD and PLAY keys simul-

taneously. The ADAT lx uses a ‘soft’ power key so lx
users will have to unplug and plug the ADAT lx
while holding down the RECORD and PLAY keys.
Clicks and pops under word clock sync
Many problems result from incorrect word
clocking. It is essential that all digital devices in the
system be word locked. Consult “Making sync
connections” on page 19 for detailed information
on how to word clock your gear. Whenever there is
any weird noise or distortion, suspect incorrect
word lock.
Clicks and pops under ADAT Sync
Sometimes, the ADAT sync cable seems to be
plugged into the MOTU 828, and it partially works.
But it isn’t really all the way in. This can cause clicks
when slaved to ADAT 9-pin. Make sure the ADAT
Sync cable plug is really seated firmly.
Clicks and pops due to hard drive problems
If you have checked your clock settings and you are
still getting clicks and pops in your audio, you may
have a drive related problem. Set your Clock
Source to Internal and try recording just using the
analog inputs and outputs of the MOTU 828. If you
encounter the same artifacts you may want try
using another drive in your computer. Clicks and
pops can also occur when the drive is severely
fragmented, the disk drivers are outdated, or if you
are using a SCSI accelerator that is not optimally
configured for working with audio.
Connecting or powering gear during operation
It is not recommended that you connect/
disconnect, or power on/off devices connected to
the MOTU 828 while recording or playing back
audio. Doing so may cause a brief glitch in the
audio.
No optical inputs or outputs are available in host
audio application
Check to make sure you have the desired optical
inputs and/or outputs enabled in the MOTU 828
Control Panel.
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Monitoring - How to monitor inputs?
Please refer to the documentation for the audio
application that you are using. If your application
does not support input monitoring, you will need
to use the MOTU 828’s hardware-based CueMix
Plus monitoring feature. Please see “Monitor input
— CueMix™ Plus” on page 37.

■ The serial number of the MOTU 828 system.
This is printed on a sticker placed on the bottom of
the MOTU 828 rack unit. You must be able to
supply this number to receive technical support.

Controlling monitoring latency
See “Monitoring live input” on page 38.

— The version numbers of the items in the MOTU
Folder (in the Extensions Folder of your startup
disk), including the MOTU 828 Enabler and
MOTU 828 Driver

CUSTOMER SUPPORT
We are happy to provide customer support to our
registered users. If you haven’t already done so,
please take a moment to complete the registration
card included with your MOTU 828. When we
receive your card, you’ll be placed on our mailing
list for free software updates and information
about new products.

REPLACING DISKS
If your MOTU 828 software or AudioDesk CDROM becomes damaged and fails to provide you
with fresh, working copies of the software, our
Customer Support Department will be glad to
replace it. You can request a replacement disc by
calling our business office at (617) 576-2760 and
asking for the customer service department.

TECHNICAL SUPPORT
If you are unable, with your dealer’s help, to solve
problems you encounter with the MOTU 828
system, you may contact our technical support
department in one of the following ways:
■ Tech support hotline: (617) 576-3066 (Monday
through Friday, 9 am to 6 pm EST)
■

Tech support 24-hour fax line: (617) 354-3068

■

Tech support email: techsupport@motu.com

■

Web site: www.motu.com

Please provide the following information to help us
solve your problem as quickly as possible:

■

Software version numbers for:

— AudioDesk

■ A brief explanation of the problem, including the
exact sequence of actions which cause it, and the
contents of any error messages which appear on the
screen.
■ The pages in the manual which refer to the parts
of the MOTU 828 or AudioDesk with which you
are having trouble.
■ The version or creation date of the system
software you are using to run the Macintosh. This
can be found by choosing About this Computer
from the Apple menu.

We’re not able to solve every problem immediately,
but a quick call to us may yield a suggestion for a
problem which you might otherwise spend hours
trying to track down.
Our technical support department is dedicated to
helping registered users solve their problems
quickly. In the past, many people have also taken
the time to write to us with their comments,
criticism and suggestions for improved versions of
our products. We thank them; many of those ideas
have been addressed in our development efforts. If
you have features or ideas you would like to see
implemented, we’d like to hear from you. Please
write to the MOTU 828 Development Team,
MOTU Inc., 1280 Massachusetts Avenue,
Cambridge, MA 02138.
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1

Index

02R mixer 25
connecting 18
1394 connector 6, 10, 15
24-bit
3rd party software 58
analog recording 9
AudioDesk 50
Digital Performer 44
optical 6, 10
recording 11

A
Aardvark Aard Sync 27
Activity LEDs 5, 11
ADAT 9-pin 10, 34
ADAT lightpipe 25
ADAT optical 6, 10
clock source setting 35
connecting 16
syncing with 34
ADAT Sync 10
connector 6
sample-accurate 21, 22, 23
sync setting 34
ADAT sync
sample-accurate 45, 51
Analog activity lights 5, 11
Analog inputs/outputs 6
converters 9
making connections to 16
trimming in 3rd party software 56
trimming in AudioDesk 50
trimming in Digital Performer 44
Apple CD Player 61
Apple menu 29
ASIO 31, 53
ASIO 2.0 MMC option 58
ASIO 2.0 option 57
driver location 54
MOTU 828 ASIO driver 29
ASIO Control Panel button 33
Audio
bit resolution 34
input/output timing 44, 50
AudioDesk 11, 29, 31, 47
828 settings 47
accessing 828 settings 33
MMC control 22
MOTU 828 settings 7
optical input/output 49
sync settings 22
AudioTap 60
Auto Monitor
AudioDesk 49
Digital Performer 43

B
Balanced analog 16
Bias Peak 53

C
CakeWalk 53

H
Headphone jack 5, 10

Calibrating audio input/output 44, 50
Clock LEDs 5, 11
Clock source 7, 19, 34
ADAT 9-pin 23, 24
AudioDesk 48
Coax 10
Condenser mic input 5
Configure Hardware Driver 7, 33
Control Panel (MOTU 828) 7, 30, 33
Control Strip 29
Control Strip module (828) 7, 30, 33
Converters 6, 9
Cubase 53
828 inputs/outputs 55
enabling the 828 ASIO driver 54
troubleshooting 61
CueMix Plus 11, 37
choosing inputs 7
output jacks 6, 16
volume control 5
Customer support 63

Headphones
connecting 17

D
DAT
connecting 17
Digital mixer
connecting 18
Digital Performer 11, 41
828 settings for 41
accessing 828 settings 33
clock source 42
MMC control 22
MOTU 828 settings 7
Optical input/output 43
sample rate 42
sync settings 22
Digital Timepiece 22
Disc
replacing 63

E
Enable Sound Manager 37
F
Fine-tune Audio I/O Timing command 44,
50
FireWire 10
connecting 15
connector 6
Foot switch 10, 37
3rd party software 56
AudioDesk 51
configuring 7
Digital Performer 45
jack 6

G
Guitar
connecting 17
Guitar (levels) 5

IInput gain 5, 11
Inputs
analog 6
optical 6
S/PDIF (RCA) 6
Installation
hardware 15
software 29
Installer CD
replacing 63
Internal (sync setting) 34

L
Latency 11, 36, 42, 48
CueMix Plus 7
w/3rd party software 56
Lightpipe 25
Logic Audio 53

M
Main outs 10
choosing CueMix monitor inputs 7
jacks 6
making connections to 16
volume 5
Main volume 5
Mic inputs
connecting 17
phantom power 5
Mic preamps 6, 10
Mic/line inputs 6, 16
MIDI Machine Control 20, 21, 45, 58
MIDI Time Code sync 20, 21
MIDI Timepiece AV 22
Mixing
using an external mixer 16
MMC 20, 21, 45, 58
Monitor input 7, 37
Monitor level 5
Monitoring 11, 36, 38
thru main outs 16
w/3rd party software 56
MOTU
Digital Timepiece 22
MIDI Timepiece AV 22
MOTU 324 Console 29
MOTU 828
ASIO driver 31
driver 29, 30
Enabler 29, 30
installing 15
rear panel overview 9
summary of features 9
MOTU 828 Control Panel 7, 30, 33
MOTU 828 Control Strip module 7, 30, 33
MOTU Audio System
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bit resolution 34
Fine-tune Audio I/O Timing 44, 50
input/output timing 44, 50
location 30
MOTU Folder 29
location 30
MTC sync 20, 21

Phones 5
Pro Tools 61
Problem-solving 61
Punch in/out 10

R
Registration 13

AudioDesk 50
Digital Performer 44
Synths
connecting 17
System requirements
minimum 13
recommended computer 11, 13

N
Neutrik jacks 6

S
S/PDIF 10

T
Technical support 63

O
Optical

clock source setting 36
lights 5, 11
optical 6, 10
RCA 6
sync 26
Sample rate 7, 34
AudioDesk 48
Sample-accurate sync 10, 21, 22, 23, 57
Samplers
connecting 17
Samples per buffer 7, 36, 42, 48
SMPTE sync 19, 20, 21, 24
Software
installation 29
Sound Control Panel 59
Sound control panel
rate (bit resolution) 34
Sound Manager 53, 59
bit resolution 34
enabling 37
input/output timing 44, 50
Studio setup (example) 17
Sync
sample-accurate 21, 22, 23
Synchronization 19
3rd party software 56

choosing format (ADAT or
TOSlink) 37
choosing format (ADAT/TOSlink) 7
connectors 6, 16
LEDs 5, 11
overview 10
sync 25
Outputs
analog 6
optical 6
S/PDIF (TOSLink) 6

P
Packing list 13
Peak 53
Pedal 10, 37
3rd party software 56
AudioDesk 51
configuring 7
Digital Performer 45
jack 6
Phantom power 5, 10, 16
Phase-lock 19

Timecode Base menu 58
TOSLink 6, 10
clock source setting 35
connecting 16
Trim (input) 5, 11
Troubleshooting 61
TRS connectors 16

U
Unbalanced analog 16
V
Video sync 19, 24
Volume
headphone 10
VST 53

W
Word clock 19, 24, 26
Y
Yamaha 02R
connecting 18
Yamaha 02R mixer 25
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